Welcome ................................................................. 1
Experience the Fun of Media Center .............. 1
Using Media Center Features ...................... 2

Using Media Center ............................................... 3
Setting Up Media Center ........................................ 3
Media Center Start Menu ..................................... 4
Using Instant Messaging in Media Center ....... 6
Changing Media Center Settings ..................... 7
Finding Additional Media Center Information ... 8

Using the Remote Control ................................. 9
Remote Control Buttons Overview .................. 10

Watching and Recording TV Programs .......... 13
Navigating My TV ................................................... 13
Watching TV ......................................................... 14
Using the Television Program Guide .............. 17
Searching for TV Programs ......................... 20
Recording TV Programs ............................... 22
Playing Recorded TV Programs ................. 25

Playing Music Files .............................................. 27
HP Tunes ............................................................. 27
My Music ............................................................ 27
Using HP Tunes with Media Center .............. 28
Adding Music to the iTunes music Library ....... 28
Playing CDs with HP Tunes ......................... 31
Creating a Playlist with iTunes ................. 31
Creating and Editing a Queue List with HP Tunes 32
Creating Music CDs with iTunes .................. 32
Using My Music with Media Center .............. 33
Adding Music to My Music Library .............. 34
Playing Music Files in My Music .................. 36
Creating a Queue List in My Music .............. 38
Finding and Playing an Album in My Music ...... 38
Creating a Playlist in My Music .................. 39
Copying Music Files to CD in My Music ........ 40

Working with Pictures ................................. 41
HP Image Zone Plus ............................................ 41
My Pictures ....................................................... 41
Working with Digital Images ......................... 41
Using HP Image Zone Plus in Media Center .... 42
Viewing Pictures in HP Image Zone Plus ......... 46
Editing Pictures in HP Image Zone Plus ........ 46
Printing Pictures in HP Image Zone Plus ......... 47
Using My Pictures in Media Center ............ 48
Adding Pictures to My Pictures ................... 49
Viewing Pictures in My Pictures ................. 50
Editing Pictures in My Pictures ................... 52
Printing Pictures in My Pictures ................. 53
Copying Pictures to CDs and DVDs .......... 54

Playing Videos ............................................... 55
Playing Digital Videos in Media Center ........... 56
Using Supported Video File Types .......... 56
Transferring and Recording Video Files ......... 57
Creating a CD/DVD from Video Files ............. 57

Playing DVDs ................................................... 59
Changing the DVD Movie Language .............. 59
Changing DVD Audio Settings ...................... 60

Listening to FM Radio ......................... 61
Playing FM Radio Stations ......................... 62
Organizing Pre-set Radio Stations .............. 63
Using the FM Radio and the TV Signal at the Same Time 63

Creating (Burning) CDs and DVDs .............. 65
Creating (Burning) CDs and DVDs with RecordNow! 65
Storing Files on a DVD or CD ......................... 67
Copying a DVD or CD ......................................... 69
Archiving Files on a CD or DVD .................. 69
Recording Video Files .................................. 69
Using Disc Labels ........................................... 70
Creating Recovery CDs/DVDs for the PC ....... 70
Using Compatibility Information ................. 70
Identifying Disc Feature and Compatibility .... 71
Using the Optical Drive Quick Reference Table 72
Using the Software Quick Reference Table .... 73
Welcome

Experience the Fun of Media Center

Microsoft Windows XP Media Center Edition 2005 lets you do amazing things with your HP Media Center PC. With a full range of easy-to-use digital entertainment features, experience movies, music, and photos like never before.

Media Center is simple and easy to use. You can easily find and choose your media. You can play movies, listen to music, view photos, and watch TV with a single remote control. Combined with the powerful features of your HP Media Center PC, you’ll enjoy the rich sounds and brilliant images for a great entertainment experience.

Watch and record live TV

With Media Center you can pause, advance frame by frame, skip ahead, or use instant replay to catch every moment of live TV. Use fast-forward to bypass unwanted content. When you are not able to watch your favorite show, you can use Media Center to record it.

Record TV with ease by using the Television Program Guide to select the shows you want to record. You can record one show or an entire series and watch it when it is convenient for you. You will never miss a moment of your favorite shows.

The right music for the moment

Browse your entire music library by artist, genre, and song. Select a playlist or a single album, or do a random shuffle from your music collection. You can even play songs from your iTunes music Library.

Share your digital photos

Organize your photos with HP Image Zone Plus, and then search for photos or albums with the ease of the remote control. Create and view personalized slide shows for viewing on your TV or PC. Add music and have fun viewing your digital memories.

Transform your living space into a theater

Whether you are watching a DVD movie or your own home videos, Media Center delivers a rich viewing experience with a high-quality digital sound system. Use the remote control and sit back and enjoy the show.
Using Media Center Features

You can control the Media Center functions and navigate Media Center windows by using the remote control, the keyboard, or the mouse. You can easily switch back and forth between them by moving the mouse or by pressing a button on the remote control or the keyboard.

You can run Media Center side-by-side with other Windows software programs. It's possible to browse through your pictures, watch videos, play music, and even record TV while using other Windows programs.

When using the remote control and the Media Center program, you can:

- Watch, record, and play back television programs on any TV or PC in the house.
- Pause, rewind, and fast-forward TV programs.
- Watch an instant replay.
- Play back your digital videos.
- View your digital pictures or play them as a slide show with music. Easily print your photos.
- Browse, select, and play music CD files with full-screen visualizations.
- Record CD tracks to your media library.
- Play DVD movies. Resume playing your DVDs where you left off.
- Listen to FM radio stations.
- Access streaming music and video subscription services.
- Record your TV shows automatically while you are doing something else.
- Open specific windows in Media Center by using the shortcut buttons on the remote control.
- Communicate with your friends and family by using instant messaging.
- Enjoy Media Center remotely (select models only).
- Easily back up your media files to CD, DVD, or another hard disk drive such as the HP Personal Media Drive.

Some of the Media Center features listed are for select models only.

The Television Program Guide may not be available in all countries/regions.
Setting Up Media Center

The first time you open Media Center, a setup wizard opens. It is best to complete each step in the Media Center setup wizard to be able to use all the features in Media Center. The Media Center setup wizard may take approximately 10 to 40 minutes to complete.

Completing the setup wizard steps

Press the Media Center Start button on the remote control, and the Media Center setup wizard opens. Follow the onscreen instructions to complete the wizard.

Listed below are some of the items included in the setup wizard:

- **Check for your Internet connection.** An Internet connection allows Media Center to download and update your Television Program Guide and display information about your music CDs and other media.

- **Configure your TV tuner, TV signal source, and Television Program Guide.** You need to provide information about your TV signal source and your TV signal equipment (set-top box, cables, and so on). This step makes sure your computer receives the correct TV signal and Television Program Guide information. If you have a cable box or satellite receiver, the setup wizard programs your remote control to work with them.

- **Optimize how Media Center looks on your display.** You can change display settings such as brightness, contrast, RGB color and centering.

- **Set up your speakers.** Select how many speakers you have and test them.
Media Center Start Menu

A  Access a menu to exit Media Center, to shut down or to restart the PC, to log off to end your Media Center session, to put the PC into standby mode, or to switch users

B  Use media playback controls: Play, Stop, Pause, Skip, Fast-Forward, Replay, Rewind, and Record, Volume Up/Down, Channel Up/Down

C  Open the Media Center Start menu

D  Go back one screen

E  Open the Media Center Help

F  Minimize the Media Center window

G  Resize the Media Center window

H  Close the Media Center window

J  Go to the Media Center Web site for the latest Media Center information

K  Watch your home videos

L  View digital pictures or play a slide show; print photos

M  Watch, record, and play back TV programs

N  Play music files or music CDs, create and edit playlists, and record music files to CD

O  Play FM radio stations

P  Find utilities and programs: instant messaging, video editing, and creating CDs/DVDs

Some of the features listed are for select models only.
Other menus not shown:

- **HP Image Zone** — View digital pictures, play a slide show, and print photos
- **HP Tunes** — Play music from your iTunes music Library or from music CDs
- **Play DVD** — Watch DVD movies
- **Settings** — Change Media Center program settings

**Navigating Media Center**

In the Media Center windows, a selected item such as a folder, file, or menu item is outlined with a green border.

You can control the Media Center functions and navigate Media Center windows by using the remote control, the keyboard, or a mouse.

To select items in Media Center by using the remote control, use the arrow buttons on the remote control, and then use the OK button to enter your selection.

If you have media playing, such as music or television, it appears in an inset window in the lower-left corner. To switch from watching your media in the inset window to watching it in full-screen mode, use the arrows on the remote control to select it, and then press OK.
Media Center menu bars and PC control menu

When you move the mouse, the Media Center menu bars appear. When you use the remote control, or when you stop using the mouse (after 5 seconds), the menu bars disappear.

To access the PC control menu from Media Center menu, move the mouse to display the menu bars. Select the **Turn Off** icon on the main Media Center window.

From this menu, you can select icons to perform various actions.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Icons" /></td>
<td>Log off and end your Media Center session and switch users</td>
</tr>
<tr>
<td><img src="image.png" alt="Icons" /></td>
<td>Turn off the PC</td>
</tr>
<tr>
<td><img src="image.png" alt="Icons" /></td>
<td>Restart the PC</td>
</tr>
<tr>
<td><img src="image.png" alt="Icons" /></td>
<td>Put the PC in a reduced power state — standby mode</td>
</tr>
</tbody>
</table>

Using Instant Messaging in Media Center

Media Center supports instant messaging so you can communicate with your friends and family while you are doing something in Media Center. You always have the option to turn this feature on or off.

You can use your remote control to log in and type messages. You can even have multiple conversations.
Logging in to your messenger account

1. First, you must go to http://www.msn.com to set up your messenger account. You will need a .NET Passport to log in to messenger. A .NET Passport is an e-mail address, a login name, and a password. Make sure you verify the account with MSN before you try to log in from Media Center.

2. Press the Media Center Start button on the remote control to open Media Center.

3. Select More Programs, and then select the Messenger icon.

4. Select Sign In.

5. Enter your .NET Passport information, and then select Sign In.

Changing Media Center Settings

In the Media Center Settings window, you can change settings for watching television, for viewing your pictures and slide shows, and for controlling sound and the display of all the Media Center windows.

To change your Media Center settings:

1. Press the Media Center Start button on the remote control.

2. Select Settings.

3. Select a category.

4. Select one of the settings listed. Then, use the arrow buttons to select an option or follow the onscreen instructions.

5. Select Save to save your changes.
Media Center settings categories

- **TV** to set up TV signal, audio, and closed captioning. You can download or edit the Television Program Guide, view or clear recording history, set hard disk drive recorder storage space, configure your display, and set recording defaults.

- **Pictures** to set slide-show settings.

- **Music** to select visualizations or song information to display when playing a song.

- **DVDs** to select a language for subtitles, audio tracks, and menus of your DVDs, program the remote control buttons for your DVDs, and select closed captioning. You can also access audio settings for your speakers. You must use a mouse or keyboard to select the audio settings.

- **Messenger and Caller ID** to allow instant messages within Media Center and set notifications for caller ID.

- **Radio** to organize or delete pre-set radio stations.

- **General** to set:
  - **Startup and Window behavior.**
  - **Visual and Sound Effects** to set transition animations and sounds when navigating in Media Center.
  - **More Program Options** to change settings for other programs on the PC.
  - **Media Center Setup** to configure your Internet connection, TV signal, speakers, TV, or monitor; access Windows updates; run Media Center setup again; set up remote desktop; and reset Start Page defaults.
  - **Parental controls** to block unwanted TV channels and block unwanted TV and movie ratings, change access code, and reset parental controls.
  - **Automatic Downloads Options** to get media information about CDs, DVDs, and movies from the Internet and to select how to download the Television Program Guide.
  - **Help** to find help about using Media Center and your hardware.

Finding Additional Media Center Information

To learn more about using Media Center, refer to the online and other Help files located in Media Center. Using your mouse, click the **Help** icon in the Media Center toolbar.

You can select **Online Spotlight** from the main Media Center menu to go online for the latest Media Center tips and other information.

Also, you can access the Microsoft Windows XP Media Center Edition 2005 Reference Guide when you go online to the HP Support Web site at:

http://www.hp.com/support

To find your online documentation, search for your model number and then click **Manuals**.
Using the Remote Control

The remote control is designed to work with Media Center. You can use your remote control with Media Center to play CDs, DVDs, to view pictures, and to watch and record television programs.

This remote control helps you navigate the Media Center windows on your computer just as a TV remote control helps you navigate cable TV options or control the playback of a movie in a VCR or DVD player.

**The remote control can:**
- Navigate and control all Media Center windows.
- Control the video or live TV display.
- Place the computer in and out of standby mode.
- Shut down or restart the PC.
- Log off from Media Center or switch users.

**The remote control cannot:**
- Navigate the Windows desktop or control other computer programs outside of Media Center.
- Be used as a VCR, DVD player, or stereo remote control.
- Turn on or off a TV that is connected to your PC.
- Turn on the PC.

The remote control has a range of about 26 feet. Make sure there is nothing blocking the pathway between your remote control and the remote sensor.
Remote Control Buttons Overview

Features and location may vary

A **Standby** 🌟 puts the PC into and out of a power-reduced state.

B **DVD Menu** opens the Play DVD window or opens the main menu of a DVD movie, if available.

C **Music** opens the My Music window.

D **Radio** opens the Radio window.

E **Record** records a selected television program and stores it on the hard disk drive when in Live TV mode. The Record button is inactive for all other media.

F **Rew (Rewind)** moves the media backward at two speeds.

G **Replay** moves media backward 7 seconds.

H **Pause** pauses audio and video tracks and live or recorded TV programs.

J **Back** returns PC to the previous window within Media Center.

K **Arrow** buttons move the cursor to navigate and select actions within all Media Center windows.

L **Start** opens Media Center to the main Start menu.

M **Volume** increases (+) and decreases (–) volume.

N **Live TV** is a shortcut to the full-screen view of live TV. Moves a TV program forward to the end of the pause buffer and resumes playing live TV.

O **Guide** opens the Television Program Guide.

P **Clear** deletes the last character entered.

---

**If you turn off (shut down) your PC, Media Center will not record a scheduled TV program. The PC must be turned on or in standby mode to record TV programs.**

**Make sure you turn off the monitor and turn down or mute the volume, for example, if you have a scheduled recording in the middle of the night and don’t want to be disturbed.**

The PC will not automatically go into standby mode if Media Center is open. It is best to close Media Center before you manually place the PC in standby mode.
Q TV opens the My TV window.
R Pictures opens the My Pictures window.
S Videos opens the My Videos window.
T Play plays the selected media.
U Stop stops the media currently playing.
V Fwd (Fast-forward) moves media forward at three speeds.
W Skip moves media forward — for example, 30 seconds in videos and live TV or one music track.
X More (i) displays available information about a selected media file and displays other menus.
Y OK selects the desired action or window option and acts as the Enter key.
Z CH/PG up (+) and down (–) changes the TV channels or moves pages up and down, depending on available options. Moves to the next DVD chapter.
AA Mute turns computer sound off. The word Mute is displayed when Mute is turned on.
BB Recorded TV opens the Recorded TV window where recorded TV programs are listed.
CC 0 to 9, #, * are the numeric keypad buttons to change channels or enter text into a Media Center search or text box. Each time you press a number button, a different character appears. Press the Enter button to select a character.
DD Enter selects the desired action, menu, or window option.
EE Print prints your pictures that you select in the My Pictures window of Media Center.
Watching and Recording TV Programs

Watch live TV or record your favorite shows for later playback. Use the Television Program Guide to find the show you want to watch or record. You can also record a show while watching another prerecorded show.

Navigating My TV

From the My TV window you can search for and play your favorite TV shows. Use the following menu items to help you locate what you want to do:

- **Live TV**: Watch, pause, fast-forward, or rewind your favorite TV shows. You can watch recorded TV shows while recording another show. Use the More information button on the remote control to display TV show information.

- **Recorded TV**: View a list of recorded programs by date or title, view a list of programs scheduled to be recorded, play a recorded program, find out why a program wasn’t recorded, or add a TV recording manually.

- **Search**: Quickly find a TV program or a series to watch or record by entering a descriptive word, program title, or program category.

- **Guide**: (Not available in all countries/regions.) Scroll through the free Television Program Guide to find programs to watch and record. You can record specific TV shows or a whole series to your hard disk drive or an HP Personal Media Drive.

- **Movies**: (Select models only.) Go online to find movies to watch now or later. Get the latest information about movies on TV: read reviews, see cast lists, find other times the movie is broadcast, view the DVD cover, browse for related movies, and find other movies with the same cast members.

Digital video recording features and the Television Program Guide are for select models only.

The Movies online information feature is available for some countries/regions.
Watching TV

Before you can watch TV by using Media Center, make sure:

- The computer is set up correctly for your TV signal source. Refer to the setup poster and the HP Media Center Getting Started Guide for more information.
- You have completed the Media Center setup wizard. If you have not completed the setup wizard, refer to “Completing the setup wizard steps” on page 3.

Watching Live TV

1. Press the TV button on the remote control or select My TV from the main start menu. Use the arrow buttons on the remote control to select Live TV, and then press OK. The last channel selected or the first channel available begins playing.

2. Select a channel by using the CH/PG (+) or (–) buttons or by using the numeric keypad on the remote control, and then press Enter on the remote control. The channel number and program information are displayed in the window.

3. Press the More information button to open another menu with the following options and information:
   - A zoom option.
   - Access to Messenger and Settings windows.
   - Program information such as channel number and station, title and time period of program, actual time, and a brief summary of the program and TV rating, if available. Recording options are also shown.

4. To exit full-screen mode and return to the previous window, press Back on the remote control.
**Controlling TV playback**

The personal video recorder functionality lets you record single shows or capture entire series for later viewing.

When you open the My TV window and begin watching live TV, Media Center begins recording the selected program in the background for up to 30 minutes. When you pause a live TV program while watching in full-screen mode, the time-shifting window appears.

You can return to the live broadcast by pressing the Live TV button on the remote control.

When you change the channel, Media Center deletes the previously recorded portion and begins recording again after a short delay.

You cannot use time shifting when recording a TV program. For example, you can’t pause a live TV program and then rewind to the beginning of the pause buffer and then begin recording. You can record a TV program only from live TV.

---

**The 30-minute pause buffer applies only when pausing, rewinding, and fast-forwarding live TV. Media Center allows you to record a program for longer than 30 minutes.**

---

**The digital video recording features are for select models only.**
### Using the remote control in My TV

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Pause" /></td>
<td>To freeze the live TV image, press Pause. While paused, My TV continues to record a pause buffer for up to 30 minutes. To resume watching TV where you left off, press Play.</td>
</tr>
<tr>
<td><img src="image" alt="Stop" /></td>
<td>To stop live TV or a recorded program, press Stop once. To resume watching the program, press Play.</td>
</tr>
<tr>
<td><img src="image" alt="Fast-Forward" /></td>
<td>To move forward in the live TV program that has been paused, or in a recorded program, press Fast-Forward (Fwd). To speed up the fast-forwarding, press Fwd two or three times. Fwd allows you to skip 3 hours in the Television Program Guide.</td>
</tr>
<tr>
<td><img src="image" alt="Play" /></td>
<td>To play a recorded TV program or to resume watching a program after pressing the Pause, Fast-Forward, Rewind, Replay, or Skip buttons.</td>
</tr>
<tr>
<td><img src="image" alt="Skip" /></td>
<td>To advance in live TV or in a recorded program by 30 seconds, press Skip once. You can repeatedly skip forward, but only to the end of the pause buffer or the recorded program. Allows you to skip 12 hours in the Guide.</td>
</tr>
<tr>
<td><img src="image" alt="Rewind" /></td>
<td>To move backward in live TV or a recorded program, press Rewind (Rew). To speed up rewinding, press Rew three times. To resume watching the program, press Play. Rew allows you to move back 3 hours in the Guide.</td>
</tr>
<tr>
<td><img src="image" alt="Replay" /></td>
<td>To move backward in live TV by 7 seconds, press Replay. You can repeatedly rewind with the instant replay option, but only to the beginning of the pause buffer or recorded program. Allows you to move back 12 hours in the Guide.</td>
</tr>
<tr>
<td><img src="image" alt="Live TV" /></td>
<td>To maximize the TV viewing window to full-screen mode, press Live TV. Also, to advance to the end of the pause buffer and resume watching the live TV broadcast, press Live TV.</td>
</tr>
<tr>
<td><img src="image" alt="More information" /></td>
<td>To see the channel number, station identifier, title of program, time slot, and category of program, press the More information button while in full-screen mode. If you select a recorded show and then press the More information button, you can access more information about a program, stop or delete a program, record a series, change the “Keep Until” setting, copy a selected program to CD/DVD, access the instant messaging dialog box, and access TV settings.</td>
</tr>
<tr>
<td><img src="image" alt="CH/PG" /></td>
<td>To move to the next channel or page in the Television Program Guide, press the CH/PG (+) and (-) buttons.</td>
</tr>
<tr>
<td><img src="image" alt="Guide" /></td>
<td>To open the Television Program Guide, press Guide. When in the Guide window, press Guide again to view a program categories menu. To filter your Guide to display only programs in a category, you can select a category, such as Drama.</td>
</tr>
</tbody>
</table>
Using the Television Program Guide

In the Television Program Guide, you can scroll through a list of the current and upcoming television programs and channels available from your television service provider. The Guide displays the channel and network, as well as the program title, scheduled time block, and a brief description of the program. The number of days displayed depends on your television service provider; most providers display up to 14 days. By selecting a program title, a detailed description of the program appears at the bottom of the window.

Important information about the Television Program Guide

Television Program Guide data may not be available in your country/region. You can still record TV programs without a Guide; see “Recording TV without the Television Program Guide” on page 23.

If there is no Guide data available when you try to download or search for Guide information, the following messages may appear:

- **Download Incomplete**: We were unable to locate any Guide information for the following reason: Guide data is not available for the country or region setting you selected in the Control Panel Settings.
- **Search in My TV is unavailable because there is no Guide information.**
- **The current lineup and/or location selected for the Guide is not supported.**
- **The Guide information is either missing or corrupt.**
- **No data available.**
- **Channel information is currently not available.**

If you receive any of these messages, then the Guide data is not available in your country/region, and you cannot use Television Program Guide features. Check back periodically to see if Guide data has been provided.
Viewing the Television Program Guide

1. Press the Media Center Start button on the remote control.
2. Select My TV, and then select Guide.
3. Use the arrow buttons to select a channel, and then use the arrow buttons to scroll through up to two weeks of programming for that channel.
4. Select a program, and then press OK to watch it. Press the Record button on the remote control to record the program.

If you press the Guide shortcut button on the remote control while you are already in the Guide, you can select one of the Guide filter categories, such as Movies, to search for a movie.

When you select a channel and then press OK on the remote control, you can view up to two weeks of programming. Use the scroll arrows at the bottom of the window.

Press the More Information button on the remote control to access another menu for more options of searching your Guide.
Setting up how Media Center downloads the Guide

You must select a TV listings provider before you can use and download the Guide. You can set up Media Center to download the Guide when you connect to the Internet or you can select to manually download the Guide.

1. Press the Media Center Start button on the remote control.

2. Select Settings, General, Automatic Download Options, and then select:
   - Connect to the Internet and download: Media Center connects to the Internet, and then downloads the Guide.
   - Or
   - Download when connected: Connect to the Internet, and Media Center automatically downloads the Guide.
   - Or
   - Manual download: Connect to the Internet and then manually download the Guide in Media Center TV Settings menu.

3. Follow the onscreen instructions. When the Television Program Guide starts downloading from the Internet, it can take up to 30 minutes, depending on the amount of data to download and the speed of your Internet connection.

Manually downloading the Guide

1. Press the Media Center Start button on the remote control.


3. Follow the onscreen instructions. The Guide can take up to 30 minutes to download, depending on the amount of data to download and the speed of your Internet connection.
Searching for TV Programs

To find a TV program, you can enter a title or keyword or select a category in your Guide by using your remote control.

1. Press the Media Center Start button on the remote control, select My TV, and then select Search.

2. Select Title. Use the numeric keypad on your remote control or your keyboard to enter a program title word, and then press OK on the remote control.

Or

Select Keyword. Use the numeric keypad on your remote control or your keyboard to enter a descriptive word that would appear in a program title or program description, and then press OK on the remote control.

3. To scroll through search results, use the arrow buttons to select a program, and then press OK. If multiple times for the program are displayed, select a time and press OK.

4. To begin watching the program in full-screen mode, select the program, and then press OK. If the program is not currently playing, select Record or Record Series, and then press OK.
Watching and Recording TV Programs

Searching for TV programs using categories

You can search the Guide to find a TV program by selecting a category using your remote control. Some categories are not available in all countries/regions.

1. Press the Media Center Start button on the remote control, select My TV, and then select Search.

2. Select Categories.

3. Select a category of program types, such as Movies.

4. Select an option such as Genres or Top Rated.

5. Select a sorting option, such as By movie title.

6. Use the arrow buttons to scroll through search results and to select a program. Then press OK on the remote control.

7. Select an option to find out more about the program, to watch it, to schedule a recording, or to view other showings of your program.
Recording TV Programs

Media Center allows you to record TV programs so that you can watch them when it is convenient. You can record the program you are watching, or you can record a future program or series from the Guide, the Search, or the Recorded TV window in My TV. You can record two programs at the same time if your PC has two TV tuners (select models only).

If a recording error occurs, the program will not be recorded unless the conflict is resolved. If you try to schedule a recording and another is already scheduled for the same time, a conflict window appears and gives you the option to record the new program or record the previously scheduled program.

To make sure your program is being recorded, select My TV, Recorded TV, and then select Scheduled. The Record icon also appears next to the program in the Guide while you are recording. The Record icon disappears when the recording is complete.

Record Series means that you select to record each episode of that program from one channel. Media Center won’t record duplicate episodes. Media Center also looks for alternative times to record an episode if a recording conflict arises.

Recording icons

- The Record icon appears in the Television Program Guide next to the program scheduled to record.
- The Record Series icon appears in the Television Program Guide next to each occurrence of a program in a series that is scheduled to be recorded.
- The Record Conflict/Error icon appears in the Television Program Guide and the taskbar if another program is scheduled to be recorded at the same time.

Recording TV from the Guide

To record a current or future program or series from the Guide:

1. Press the Media Center Start button on the remote control, select My TV, and then select Guide.

2. To find the program you want to record, use the arrow buttons on the remote control, and then select the program. You can also use the numeric keypad on the remote control to enter a channel number. Press the right arrow button in the Guide to select a program that will be broadcast in the future.

3. Press the Record button on the remote control.

   The Record icon appears next to the program in the Guide. Press Record twice to record a series.

   The Record Series icon is displayed to indicate a series. Press Record again to cancel the recording.

4. To return to the previous window, press Back on the remote control.

5. If there is a recording conflict, Media Center displays a message and allows you to select which program you want to record.

For more information about recording to your HP Personal Media Drive, see “About Recording TV to the HP Personal Media Drive” on page 96.
**Recording manually**

Recording a program manually allows you to select a specific date, channel, and recording time period. For some programs, you may want to begin recording before the scheduled beginning and after the scheduled ending of the program.

1. Press the Media Center Start button on the remote control, select My TV, Recorded TV, and then select Add Recording.

2. Select Channel and Time.

3. Select the channel number box and enter the channel number using the numeric keypad on the remote control.

4. Select the (+) or (–) buttons, and then press OK on the remote control to scroll through choices and enter the recording frequency, date, start and stop times, and storage and quality options.

5. To set the recording and return to the Recorded TV window, select Record in the window, and then press OK on the remote control.

6. To return to the previous window, press Back on the remote control.

**Recording TV without the Television Program Guide**

You do not need the Television Program Guide to record TV. You can record a TV program by pressing the Record button on the remote control while watching live TV. You can also select the program you want to record manually. See “Recording manually” on page 23.
Recording quality and hard disk drive storage space

The space available for recording TV programs depends on your hard disk drive size, the percentage of hard disk drive space allocated to recorded TV, and the recording quality setting.

To get the maximum recording time, change the recording quality to Fair instead of the default setting of Best.

<table>
<thead>
<tr>
<th>Quality of recording</th>
<th>Hard disk drive space used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Best</td>
<td>*2.7 GB/hour</td>
</tr>
<tr>
<td>Better</td>
<td>*2.4 GB/hour</td>
</tr>
<tr>
<td>Good</td>
<td>*1.4 GB/hour</td>
</tr>
<tr>
<td>Fair</td>
<td>*1.2 GB/hour</td>
</tr>
</tbody>
</table>

*This table shows approximate sizes of recorded TV program files. Some files may be smaller or larger.

Copying recorded TV programs to DVD or CD

You can record TV programs to DVD in Media Center to create a backup copy or to save space on your hard disk drive by using the following procedure. These DVDs can be played from a PC and from some set-top DVD players.

The Media Center PC includes several other recording software programs for you to create CDs and DVDs. You can use InterVideo WinDVD Creator to record the recorded TV program to a format that can be played from a PC and from some set-top DVD players. See “Using InterVideo WinDVD Creator” on page 77.

For more detailed information about recording CDs and DVDs, refer to information on the HP Support Web site at:

http://www.hp.com/support

1 Press the Media Center Start button on the remote control.
2 Select More Programs.
3 Insert a blank DVD+RW, DVD+R, CD-RW, or CD-R disc.
4 Select Create CD/DVD.
5 Select the type of CD or DVD you want (Music or Data).
6 Enter a title for your DVD by using the numeric buttons on the remote control, and then select OK.
7 Select Recorded TV.
8 Select the Recorded TV programs you want to copy to CD or DVD.
9 Select View DVD or View CD.
10 Select Create DVD or Create CD.
11 Select Yes.
12 Follow the onscreen instructions to complete burning your TV show to disc.

1 GB = 1 billion bytes when referring to hard disk drive capacity. Actual formatted capacity is less.
Playing Recorded TV Programs

Recorded TV is the storage place for all your recorded programs. In the Recorded TV window, you can sort your programs by name, date, or category. You can also delete a recorded program or series of programs and check for any recording errors.

1. Press the Media Center Start button on the remote control, select My TV, and then select Recorded TV.

2. To organize all of your previously recorded programs, select Sort by Date or Sort by Title.

3. To begin watching the program, select the recorded program you want to watch, and then press OK on the remote control.

Media Center places recorded TV programs in the Recorded TV folder that is located in your Shared Documents folder on your hard disk drive.
The HP Tunes and My Music areas in Media Center are great ways to play, organize, and back up your music files. HP Tunes is designed to work with the Apple iTunes program in your All Programs menu, and My Music is designed to work with the Windows Media Player program.

**HP Tunes**

With HP Tunes, you can play your favorite music you have added to your iTunes music library. For more information about using HP Tunes, see “Using HP Tunes with Media Center” on page 28.

**My Music**

With My Music, you can find and play your favorite music files and CDs you have added to the Windows Media Player Library. For more information about using My Music, see “Using My Music with Media Center” on page 33.
Using HP Tunes with Media Center

iTunes is a software program from Apple located in your All Programs menu that works together with the HP Tunes area in Media Center. HP Tunes is linked to your Apple iTunes music Library. Both programs work together to organize and play back your favorite music files, CDs, and created playlists.

Some tasks you must do in the iTunes program with your mouse and keyboard, and some tasks you can do from within Media Center with your remote control. For example, you must add music files to the iTunes music Library before you can access them in HP Tunes in Media Center. Also, you can record your playlists to CDs in the iTunes program but not in Media Center.

Adding Music to the iTunes music Library

To create your iTunes music Library, you can import music files from a CD, download iTunes music files from the iTunes Music Store or the Internet, or import them from your hard disk drive.

Adding music files from a CD in iTunes

1. With your mouse, click **Start** on the Windows taskbar, choose **All Programs**, **iTunes**, and then click **iTunes**.
2. Insert an audio CD.
3. Select your CD under the Source menu.
4. Make sure the songs you want to add to your library are selected. A check mark appears next to the song when it is selected.
5. Click the **Import** icon in the toolbar to bring the songs into the library.

For more information on using the iTunes program, refer to the HP Support Web site at: [http://www.hp.com/support](http://www.hp.com/support)

If your songs don’t appear in HP Tunes, make sure your songs are added to the iTunes music Library. You may need to close and open Media Center to update your display.
Adding music files from the Internet
For more information about downloading music from the iTunes Music store, refer to the Help menu in the iTunes program.

1. Connect to the Internet.
2. Follow the online instructions to download your songs. If songs are downloaded from the iTunes Music Store, they appear in your iTunes music Library.
3. If songs are downloaded to your desktop, drag them into the iTunes music Library. If the files are in an unprotected .wma format, they are encoded into .aac files by default (or into the importing format you select from the Preferences menu) and placed into the library.
4. To change your import format:
   a. Click the Edit menu, and then select Preferences.
   b. Select the Importing tab.
   c. Select the Import Using drop-down menu, and then select an import format.
5. Select Library. Songs are listed alphabetically or by the sort order of the library column heading you select.

Adding music files from your hard disk drive
If the music file is in another format, iTunes will automatically convert the file to the .aac format before it adds it to your iTunes music Library.

1. Click Start on the taskbar, choose All Programs, iTunes, and then click iTunes.
2. Click the File menu, and then select Add File to Library. Click the drop-down arrow to browse for your music files. Select your file, and then click Open.

If your songs are listed as track numbers instead of names, make sure the PC is connected to the Internet so iTunes can look up the song and album names.
Using supported music file types
You can play the following types of digital audio files in iTunes. By default, iTunes converts several file types to .aac files when you import them into the iTunes music Library.

Some file types, such as protected .wma files and other proprietary file types, are not able to be played in iTunes.

Media Center cannot play .aac files from My Music.

With iTunes, you can share .mp3, .aiff, .wav, and .aac files between other computers on a local network.

<table>
<thead>
<tr>
<th>File extension</th>
<th>File type</th>
</tr>
</thead>
<tbody>
<tr>
<td>.aac</td>
<td>Apple Lossless Encoder</td>
</tr>
<tr>
<td>.aiff</td>
<td>Apple Compressed Encoded</td>
</tr>
<tr>
<td>.wav</td>
<td>Windows audio file</td>
</tr>
<tr>
<td>.mp3</td>
<td>Audio files</td>
</tr>
</tbody>
</table>

Changing song name, genre, artist, or album in iTunes
For more information about changing name, genre, artist, or album information with iTunes, refer to the Help menu in the iTunes program. It is not possible to make these changes from within HP Tunes in Media Center.
Playing CDs with HP Tunes

When you insert a CD that has not been added to your iTunes music Library, it will be listed under Playlists or Albums. If it has been added to your library, it will be displayed under Songs, Albums, Artists, or Genres.

1. Press the Media Center Start button on the remote control, and then select **HP Tunes**.
2. Insert a CD.
3. Select **Playlists** or **Albums**.
4. Scroll through the displayed playlists or albums, and then select your CD title. If the songs on this CD weren’t added to your music library, this playlist or album will disappear when you eject the CD.

Creating a Playlist with iTunes

A playlist is a customized list of songs that you saved together and can play later or record to CD. Using playlists, you can group various digital music files together and determine the order in which you want the files to play.

You can create a playlist that includes several tracks from various CDs or even a playlist that contains background music for a slide show.

You can use iTunes or HP Tunes in Media Center to create playlists.

1. Click **Start** on the taskbar, choose **All Programs**, **iTunes**, and then click **iTunes** again.
2. Click **File**, and then select **New Playlist**.
3. Type a name for your playlist.
4. Select **Library**.
5. Drag your music files from the library to your Playlist icon.
6. Select the **Playlist** icon to check whether your songs were added. Your playlist is now available in the HP Tunes area of Media Center.
Creating and Editing a Queue List with HP Tunes

A queue (or Now Playing) list is a temporary list of songs that are scheduled to be played in the order they were selected. A queue list acts like a group of songs you select to play on a jukebox. You can continue to add songs, or you can delete songs from your queue list. You also have the option of saving your queue list as a playlist.

1. Press the Media Center Start button on the remote control, and then select HP Tunes.
2. Select Songs.
3. Use the arrow buttons on the remote control to select a song, and then press OK on the remote control to place a check mark next to the song.
4. Select Add to Queue.
5. Press the Back button on the remote control to return to the queue list. Click View Queue and then Edit Queue to select songs to move or delete.

Or

Repeat steps 2 through 4 to add more songs to your queue list.

Creating Music CDs with iTunes

To create a music CD using iTunes:

1. With your mouse, click Start on the Windows taskbar, choose All Programs, select iTunes, and then click iTunes.
2. Click the Edit menu, and select Preferences.
3. Click the Burning tab, and choose Audio CD as the disc format.
4. Click the Use Sound Check check box if you would like all songs on the CD to play at the same volume level, and click OK.
5. Click the File pull-down menu, and select New Playlist.
6. Enter a name for your new playlist, and an empty playlist window opens.
7. Drag and drop selected songs from your source to your new playlist.
8. Click the Burn Disc icon in the toolbar area. When the disc is finished recording, the Burn Disc icon disappears.
9. Insert a blank CD-R disc into your drive (double-layer DVD+R discs are not compatible).
10. Click Burn Disc to begin recording your playlist.

For more information about creating music CDs with iTunes, click the Help menu in the iTunes menu bar. For help online, go to:

http://www.hp.com/support
Using My Music with Media Center

You can copy digital music files and organize a music library by using My Music in Media Center or by using the Windows Media Player program.

Music files that are added from within My Music in Media Center are copied into the Windows Media Player Library and are then accessible from within Media Center.

In My Music you can:

- Play CDs or selected music tracks from your created Windows Media Player Library that you access in Media Center.
- Select and edit a personalized queue list of songs from your library.
- Delete songs from a music library or queue list.
- Burn your favorite songs to CDs.
- Back up your music tracks to a DVD or to an HP Personal Media Drive.

You can store your music files in the My Music folder or in other folders on your hard disk drive, but you need to add those files to the Windows Media Player Library for Media Center to be able to find and play them.
Adding Music to My Music Library

When you add music files to your My Music library, they are placed into the music library in Windows Media Player. The added music files can immediately be found and played back by using My Music in Media Center. You can also add music files to your music library from within the Windows Media Player program. For more information about adding and deleting music files to the library, use the Windows Media Player Help menu.

Adding music files from your hard disk drive

1. Press the Media Center Start button on the remote control, and then select My Music.
2. Press the More Information button on the remote control, and select Add Music.
3. Select Add folders, and then select Next.
4. Select Add folders on this computer, and then select Next.
5. Use the arrow buttons on the remote control to select a location. Press the OK button to expand a folder. When you find the folder that contains your music folder, select it by making sure an arrow appears next to the folder. Repeat this step to add additional folders, and then select Next and then select Finish.
Adding music files from a CD
To add the CD tracks to your Media Center music library:

1. Press the Media Center Start button on the remote control, and then select My Music.
2. Insert a CD into the CD drive.
3. Select Albums.
4. Select the Album CD you want to add to your music library.
5. Select Copy CD. The first time you copy a music CD you must select your copy-protection option, and then follow any onscreen instructions.
6. Select Yes to begin copying tracks to your music library. This process may take several minutes, depending on the length of your music tracks.
7. Click OK.

Each time you add music files outside of Windows Media Player, you must use the Tools menu to add music files to your Windows Media Player Library for Media Center to find them.

Deleting music files from the My Music library

1. Press the Media Center Start button on the remote control, and then select My Music.
2. Select Songs.
3. Use the arrow buttons on your remote control to scroll through your songs. Select the song you want to delete, and then press OK on the remote control.
4. Select Delete, and then select Yes.
Using supported music file types

You can play the following types of digital audio files in My Music. Refer to Windows Media Player Help for more information about supported file types.

<table>
<thead>
<tr>
<th>File extension</th>
<th>File type</th>
</tr>
</thead>
<tbody>
<tr>
<td>.cda</td>
<td>CD audio</td>
</tr>
<tr>
<td>.wav</td>
<td>Windows audio file</td>
</tr>
<tr>
<td>.mp3, .m3u</td>
<td>MP3</td>
</tr>
<tr>
<td>.asx, .wm, .wma, .wmv, .wmp, .wmx</td>
<td>Windows Media audio files</td>
</tr>
</tbody>
</table>

For more information about music file formats, use Windows Media Player Help and Media Center Help.

Only supported audio file types are displayed in the My Music window. Unsupported files won’t play.

You can place all your music files into the My Music folder or into other folders on your hard disk drive, but you need to add those files to the Windows Media Player Library for Media Center to be able to find and play them.

Playing Music Files in My Music

When you first open Media Center and open the My Music window, you may not find any music files listed unless there is a music CD in your CD drive or unless you have already added audio files to your Windows Media Player Library.

When you copy music files using Windows Media Player and your computer is connected to the Internet, the CD information is copied and displayed in Media Center and in the Windows Media Player Library.

If you insert a music CD when Media Center is not open, a message appears asking what you want to do. You can select Windows Media Player as your default audio player. If you have another program set as the default audio player, Windows opens the program and begins playing the CD.
Playing an album in My Music

1. Press the Media Center Start button on the remote control.
2. Select My Music.
3. Insert a music CD into the CD drive.
4. Select Albums.
5. Select the album you want to play.
6. Select Play.

Playing a song in My Music

You can play a song from anywhere in My Music. You can select it from the View Song list, or from the Album, Artist, and Genre lists. You can also play a single song from a playlist:

1. Press the Media Center Start button on the remote control.
2. Select My Music.
3. Select Songs. The list displays all the songs in your library.
4. Use the arrow buttons to select a song, and then press OK on the remote control to play it.

You can select Visualize in the Now Playing window to see a visualization while you play a music track.
Creating a Queue List in My Music

A queue list is a temporary list of songs that is created in My Music as you select songs, albums, or playlists to play. You can continue to add songs or you can delete songs from your queue list.

You can create a queue list and save it as a playlist that you can access in Media Center.

1 From the My Music window:
   ■ Select Songs, and then use the arrow keys to select a song you want, and then select Add to Queue.
   Or
   ■ Select Albums or Playlists, select an album or a playlist, and then select Add to Queue to add the entire album or playlist to the queue.

2 Use the Back button on the remote control to go back to the Songs, Albums, or Playlists menu if you want to select more songs to add to your queue list. Repeat step 1.

3 After you add the last song for your queue list, select Play. All songs in your queue list are played in the order you have selected them.

Finding and Playing an Album in My Music

1 In the Media Center Start menu, select My Music, and then select Albums.

2 Use the arrow buttons to select an album, and then press OK on the remote control. You can also press Play on the remote control to play the album. The Now Playing window opens, and the album starts playing.

3 In the Play window, you can also select:
   ■ View Cover to view cover art and play one track.
   ■ View Queue to view an ordered list of all tracks that will be played on the album.
   ■ Shuffle to rearrange the play order.
   ■ Repeat to play the album again.
   ■ Copy CD to copy an album into your Media Library.
   ■ Buy Music to connect to the Internet, find CD information, and buy music CDs. To go back to Media Center, press Start on the remote control.
   ■ Visualize to view a picture while listening to a song.

4 To return to the previous window, press Back on the remote control.
Creating a Playlist in My Music

A playlist is a customized list of songs you can keep to play later or record to CD. Using playlists, you can group various digital music files together and determine the order in which you want the files to play.

You can create a playlist that includes several tracks from various CDs or even a playlist that contains background music for a slide show.

You can create playlists in Windows Media Player or from within Media Center.

To create a playlist:

1. Select **My Music**, and then select either **Albums**, **Artists**, **Playlists**, **Songs**, or **Genres**.
2. Use the arrow buttons to navigate to the music you want to add to your playlist.
3. Press OK to select a song.
4. Select **Add To Queue**. A confirmation displays that the music was added to the list of music in the queue.
5. Select the inset window in the lower-left corner to go to the Queue.
6. On the Queue screen, select **Edit Queue**, and then select **Save As Playlist**.
7. Use the numeric keypad to enter a name for the playlist, and then select **Save**.

If your PC is connected to the Internet, the CD track titles and cover art appear in Media Center.
Copying Music Files to CD in My Music

To copy your music files to CD:

1. Press the Media Center Start button on the remote control, and select More Programs.
2. Insert a blank CD-R disc.
3. Select Create CD/DVD.
4. Use the arrow buttons on the remote control to select the Untitled text box.
5. Use the numeric keypad buttons on the remote control to enter a name for your CD, and then select OK.
7. Select the music files to record. A check mark appears next to the song when it is selected. Use the Back button on the remote control to select more songs from different menus.
8. When you are finished adding songs, select View CD to see the songs you have selected. If you want to delete songs, use the arrow buttons on the remote control to select the X next to the song you want to delete. Press OK on the remote control to delete the song from your list of songs to be recorded to CD. This does not delete the song from your library.
9. Select Create CD.
10. Select Yes.

IMPORTANT: HP supports the lawful use of technology and does not endorse or encourage the use of our products for purposes other than those permitted by copyright law.
Use the HP Image Zone Plus and My Pictures areas in Media Center to view and print your pictures.

**HP Image Zone Plus**

HP Image Zone Plus is a software program located in your All Programs menu that works together with the HP Image Zone Plus area in Media Center. Both programs work together to organize, search for, and display your digital images. It is designed to organize your photos, scanned images, and video clips by date, keyword, or place. For more information about using HP Image Zone Plus, see “Using HP Image Zone Plus in Media Center” on page 42.

**My Pictures**

With My Pictures, you can view and print your pictures from the folders you create in the My Pictures directory in Windows Explorer. For more information about using My Pictures, see “Using My Pictures in Media Center” on page 48.

**Working with Digital Images**

You can connect a digital image source, such as a digital camera or a digital video camera, directly to the PC or through a docking station. Most digital picture files you copy or download from the device appear in the My Pictures folder.

You can copy digital picture files from the memory cards used by digital cameras and other digital imaging devices by using the memory card reader (select models only).
Using HP Image Zone Plus in Media Center

Some tasks you must do in the HP Image Zone Plus program on your desktop with your mouse and keyboard, and some tasks you can do from within Media Center with your remote control. For example, you must add your pictures to the HP Image Zone Plus program on the desktop before you can access them in the HP Image Zone Plus area in Media Center.

For specific details on using the HP Image Zone Plus program, click the Help link in the control area of the program window.
Creating your picture catalog in HP Image Zone Plus

The first time you open the HP Image Zone Plus program, a message appears asking you if you want to create a catalog by indexing images in the My Pictures folder and its subfolders. This catalog allows you to search for your pictures by date, keyword, or place by using HP Image Zone Plus.

1. Using the mouse, double-click the HP Image Zone Plus icon on your desktop.

Or

Click Start on the taskbar, choose All Programs, HP, and then click HP Image Zone Plus. The HP Image Zone Plus window opens.

2. When the catalog message appears, click OK to index the PC images and place them in the HP Image Zone Plus catalog.

3. At the top of the gallery window, click the My Images tab (A), and then click the Select All check box below it to see all of the images in the catalog. You can also select a drive under the Folders Menu (B) to browse for images.

4. Click Help at the bottom of the window for more information about creating your picture catalog in HP Image Zone Plus.

You can click Go to My Pictures at the top of the HP Image Zone Plus window to open the My Pictures folder in Windows Explorer.

A Mode tabs are used to choose a work area.

B The Preferences button is used to customize HP Image Zone Plus and change some tab settings.

C Gallery of images.

D Selection tray displays images that you have selected.
Creating albums
You can organize your pictures into albums by using the HP Image Zone Plus program. After you create your picture albums in HP Image Zone Plus, you can then view them in Media Center.

To create an album:

1. Using your mouse, double-click the HP Image Zone Plus icon on the desktop.
2. Click the My Images tab.
3. Select the pictures that you want to place into an album.
4. Click Albums under View/Search.
5. Click Albums, and then select New Album.
6. To change the title of the album, just select it and type in a title using your keyboard. You can now view your albums in Media Center.

Modifying a date assigned to your pictures
Digital cameras and scanners assign a creation date to digital images. HP Image Zone Plus automatically recognizes this creation date and organizes your pictures by date.

To change a date:

1. Using your mouse, double-click the HP Image Zone Plus icon on the desktop.
2. Click the My Images tab, and then click All by Date under View/Search.
3. Select a picture to assign a new date.
4. Select a date, and then click Set.

Assigning a keyword to your pictures

1. Using your mouse, double-click the HP Image Zone Plus icon on the desktop.
2. Click the My Images tab, and then click All by Keyword.
3. Select your picture by clicking it. You can select more than one picture, if desired.
4. Click My Selections Menu at the bottom of the window, choose Keywords, and then click Assign to All (New Keyword).
5. Select a keyword from the available keywords list, and then use the arrow button to add the keyword to the Assign to all box. Click Assign, and then click OK.

Or

Click New, type in a keyword, and then click OK. The new keyword is added to the keyword list. Use the arrow button to add the keyword to the Assign to all box.
Assigning a place to your pictures

1. Using your mouse, double-click the HP Image Zone Plus icon on the desktop.
2. Click the My Images tab, and then click All by Place under View/Search.
3. Select your picture by clicking it. You can select more than one picture, if desired.
4. Click Assign and then click Assign again.
5. Click the map to find your location. Each time you click the map, it zooms in closer. Use the arrow buttons surrounding the map to move around on the map. When your location is in the center of the cross symbol, click Assign.
6. Click OK.
7. Click Close.

Searching for pictures in HP Image Zone Plus

You can search for pictures by date, keyword, and place by using your remote control or mouse in Media Center. HP Image Zone Plus automatically organizes your pictures by date, based on the date assigned by the camera when the picture was taken or the date the picture was scanned.

1. Press the Media Center Start button on the remote control.
2. Select HP Image Zone.
3. Select Search.
4. Select By date. Use the number keypad on the remote to enter the start and end date range. The date range of the pictures you selected is displayed in this window.

Select By keyword. Select a keyword, and then press OK on the remote control.

Or

Select By place. Use the arrow buttons on the remote control to rotate the globe and numbers 1 through 5 to zoom in or out. When you have picked a location, press OK. Locations that have pictures assigned to them will have a colored dot on the map.

There are multiple ways to move around the HP Image Zone Plus map: you can click and drag or point and click the small globe.

You must open the HP Image Zone Plus program from the desktop to assign dates, keywords, and places to your pictures.
Viewing Pictures in HP Image Zone Plus

Viewing a slide show in HP Image Zone Plus
When viewing images, you can view a slide show of all your images, individual albums, or pictures selected from a search.

1. Press the Media Center Start button on the remote control.
2. Select HP Image Zone.
3. Select the pictures you want to view as a slide show, and then press OK. If you do not select the pictures you want to view as a slide show, Media Center displays all pictures.
4. Select Play slide show, and then press OK on the remote control.
5. Use the media playback keys on the remote control or the controls that appear at the top of the window to control the playback of your slide show.

Viewing a slide show with music in HP Image Zone Plus

1. Select My Music on the Media Center Start menu.
2. Select the music you want, and then press OK on the remote control. If the music doesn’t start automatically, press the Play button on the remote control.
3. To go back to the Media Center Start menu, press Start on the remote control.
4. Select HP Image Zone.
5. Select the pictures, and then press OK.
6. Select Play slide show, and then press OK. When Media Center switches to full-screen mode, the inset window disappears but the music continues to play.

Editing Pictures in HP Image Zone Plus
You can make changes to your pictures and video clips in HP Image Zone Plus. Some of the editing features include removing red eye, cropping or resizing images, rotating images, and adjusting the color, brightness, and sharpness of your images.

For more information about the editing tools, refer to the Help menu in the HP Image Zone Plus program.
Using supported picture file types with HP Image Zone Plus

HP Image Zone Plus supports the following types of image files, video files, and audio files.

- Only supported image file types are displayed in My Pictures. Unsupported files are skipped in a slide show.
- Corrupted and unsupported image file types display a generic image icon but cannot be displayed in Media Center.
- Some file types are supported only if appropriate filters and software are installed.

<table>
<thead>
<tr>
<th>File extension</th>
<th>File type</th>
</tr>
</thead>
<tbody>
<tr>
<td>.jpg, .jpeg</td>
<td>Joint Photographic Experts Group</td>
</tr>
<tr>
<td>.tif, .tiff</td>
<td>Tagged Image File Format</td>
</tr>
<tr>
<td>.gif</td>
<td>Graphics Interchange Format</td>
</tr>
<tr>
<td>.bmp</td>
<td>Bitmap</td>
</tr>
<tr>
<td>.fpx</td>
<td>FlashPix Bitmap</td>
</tr>
<tr>
<td>.pcx</td>
<td>Bitmap Graphics (PC Paintbrush)</td>
</tr>
<tr>
<td>.pdf</td>
<td>Portable Document Format</td>
</tr>
<tr>
<td>.png</td>
<td>Portable Network Graphics</td>
</tr>
</tbody>
</table>

Printing Pictures in HP Image Zone Plus

1. Press the Media Center Start button on the remote control.
2. Select HP Image Zone.
3. Select the picture group you want to print from.
4. Select Print images.
5. Select the picture you want to print.

You need to set up your printer before you can print from Media Center.
Using My Pictures in Media Center

My Pictures is a folder on your hard disk drive in the My Documents folder, and it is a Media Center menu item that allows you to view and search for your digital images by using the remote control or the keyboard and mouse.

It provides all the tools you need for viewing, organizing, editing, printing, sharing, and protecting your digital images.

My Pictures in Media Center

My Pictures folder in Windows Explorer
Adding Pictures to My Pictures

Adding picture files from your hard disk drive

1. Press the Media Center Start button on the remote control, and then select My Pictures.
2. Press the More information button on the remote control and select Add Pictures.
3. Select Add folders, and then select Next.
4. Select Add folders on this computer, and then select Next.
5. Use the arrow buttons on the remote control to select a location. Press the OK button to expand a folder. When you find the folder that contains your picture folder, select it by making sure an arrow appears next to the folder. Repeat this step to add additional folders, and then select Next.
Viewing Pictures in My Pictures

After you organize your pictures in the My Pictures folder in Windows Explorer, open Media Center to view your pictures:

1. Press the Media Center Start button 📡 on the remote control.

2. Select My Pictures. The right side of the window shows a small picture image (thumbnail) and, if you’ve organized your pictures into folders, folder icons. The pictures are displayed just as you organized them in the My Pictures folder in Windows Explorer.

3. Use the arrow buttons on the remote control to move through your picture files and folder files, and select a picture.

4. Press OK to select a picture or folder to view. The selected picture opens in full-screen mode.

5. Press OK again to zoom in 150%; press OK again to zoom in 225%. Press the arrow buttons to pan across a picture. To return the picture to the original size, press OK a third time.

Viewing pictures as a slide show

1. Press the Media Center Start button 📡 on the remote control.

2. Select My Pictures.

3. Select the folder of pictures you want to view as a slide show, and then press OK.

4. Select Play Slide Show, and then press OK.

5. Press the More information button on the remote control, and then select Picture Details. The picture name, location on the PC, last modification date and resolution appear, if available.

6. Press the Back button to go to a previous picture. Use the arrow buttons to display the next or previous pictures.

If you do not select the pictures you want to view as a slide show, Media Center uses the first folder listed. If you have picture files that are not stored in folders you created, Media Center plays all files stored in the My Pictures folder.
**Viewing a slide show with music in My Pictures**

1. Select **My Music** on the Media Center Start menu.
2. Select the music you want, and then press OK on the remote control. If the music doesn’t start automatically, press the Play button on the remote control.
3. Press the Media Center Start button  on the remote control to go back to the Media Center Start menu.
4. Select **My Pictures**.
5. Select the folder of pictures, and then press OK.
6. Select **Play Slide Show**, and then press OK. When Media Center switches to full-screen mode, the inset window disappears but the music continues to play.

**Using supported picture file types in My Pictures**

You can view the following types of image files in Media Center.

<table>
<thead>
<tr>
<th>File extension</th>
<th>File type</th>
</tr>
</thead>
<tbody>
<tr>
<td>.jpg, .jpeg</td>
<td>Joint Photographic Experts Group</td>
</tr>
<tr>
<td>.tif, .tiff</td>
<td>Tagged Image File Format</td>
</tr>
<tr>
<td>.gif</td>
<td>Graphics Interchange Format</td>
</tr>
<tr>
<td>.bmp</td>
<td>Bitmap</td>
</tr>
<tr>
<td>.wmf</td>
<td>Windows MetaFile</td>
</tr>
<tr>
<td>.png</td>
<td>Portable Network Graphics</td>
</tr>
</tbody>
</table>

- Only supported image file types are displayed in My Pictures. Unsupported files are skipped in a slide show.
- Folder icons appear even if the images inside them cannot be displayed.
- Corrupted and unsupported image file types display a generic image icon but cannot be displayed in Media Center.
- Some file types are supported only if appropriate filters and software are installed.

If the message *Image cannot be displayed* appears, the file may be corrupted or it may be an unsupported file type. You may need to edit your image with a photo editor and save it in a supported file format.
Editing Pictures in My Pictures

Fixing red eye or contrast

1. Press the Media Center Start button on the remote control.
2. Select My Pictures.
3. Select the picture you want to edit.
4. Press the More information button on the remote control, and then select Picture Details.
5. Select Touch Up.
6. Select Red Eye or Contrast, and then press OK.
7. After you select the options you want to fix, select Save. The picture is displayed with the new settings.
8. Select Yes to save changes and replace the original picture file.

Cropping pictures in My Pictures

1. Press the Media Center Start button on the remote control, and select My Pictures.
2. Select the picture you want to edit.
3. Press the More information button on the remote control, and then select Picture Details.
4. Select Touch up, and then select Crop.
5. Select the arrows under the picture to move the picture side to side, up, or down. Select the magnifying glass to move the cropping tool in or out. Select the rotate tool to move the cropping tool to a vertical or horizontal position.
6. After you select the options you want to fix, select Save. The picture is displayed with the new settings.
7. Select Yes to save changes and replace the original picture file.
Rotating pictures
If your picture appears horizontally or vertically and you want to change the orientation, you can change it in Media Center:

1. Press the Media Center Start button on the remote control.
2. Select My Pictures.
3. Select the picture you want to rotate.
4. Press the More information button on the remote control, and then select Picture Details.
5. Select Rotate, and then press the OK button on the remote control.

Printing Pictures in My Pictures

1. Press the Media Center Start button on the remote control.
2. Select My Pictures.
3. Select the picture you want to print.
4. Press the More information button on the remote control, and then select Picture Details.
5. Select Print, and then select Print again.
6. Follow any onscreen instructions.

You may need to set up your printer before you can print from Media Center.
Copying Pictures to CDs and DVDs

1. Press the Media Center Start button 🎥 on the remote control.
2. Select **More Programs**.
4. Select **Create CD/DVD**.
5. Select the Untitled area, and enter the name of your disc by using the numeric keys on the remote control, and then select **OK**. Use the Clear button to delete letters.
6. Select **Pictures**.
7. Select the pictures you want to copy. A check mark appears next to a picture when you select it.
8. Select **View CD/View DVD**. From here you can delete a picture, add more pictures, or change the name of your disc.
9. After you have selected all of your pictures, select **Create CD/Create DVD**.
10. Select **Yes**. Media Center displays a message when you disc has been created.

In Media Center, all pictures are copied to CDs as .jpg files.
The My Videos window in Media Center makes it easy to play home video files you created or video files you downloaded from the Internet.

In My Videos you can:

- Play videos that are stored anywhere on your hard disk drive.
- Create a CD or DVD of your video files.
- View your videos in full-screen mode or from an inset window in Media Center.
- Display your video details such as the name and date your video file was modified.
- View small image (thumbnail) and title of video file.

Each user has a separate My Videos folder that can be opened only by that person. You can share videos with others by storing them in the Shared Video folder.
Playing Digital Videos in Media Center

After you organize your videos in the My Videos or Shared Video folder in Windows Explorer, open Media Center to watch your videos.

1. Press the Media Center Start button on the remote control.
2. Select My Videos.
3. Select the video folder you want, and then press OK. The video folder opens, displaying a list of video files. You may need to use the scroll arrows at the bottom of the window to display all videos.
4. Select the video file, and press OK again. The video plays in full-screen mode. Use the mouse to resize the window if you want to watch your video while doing something else on your desktop.
5. To exit full-screen mode and return to the previous window, press Back on the remote control. Your video continues to play in the inset window.
6. When the video is finished, select Restart, and then press OK to replay the video, or select Done to close the file and return to the My Videos window.

Using Supported Video File Types

You can view the following types of video files in Media Center. Other file types are supported if your PC has the correct software installed.

<table>
<thead>
<tr>
<th>File extension</th>
<th>File type</th>
</tr>
</thead>
<tbody>
<tr>
<td>.avi</td>
<td>Video file</td>
</tr>
<tr>
<td>.mpeg, .mpg,</td>
<td>Movie file</td>
</tr>
<tr>
<td>.mpe, .m1v,</td>
<td></td>
</tr>
<tr>
<td>.mp2, .mpv2</td>
<td></td>
</tr>
<tr>
<td>.wm, .asf</td>
<td>Windows Media file</td>
</tr>
<tr>
<td>.wmv</td>
<td>Windows Media A/V file</td>
</tr>
</tbody>
</table>
Transferring and Recording Video Files

Once you capture your video to the PC by using video capture and editing software, you can use Media Center to find it and add it to your My Videos area.

Recording an analog video file
Refer to “Capturing Analog Video with WinDVD Creator” on page 80 for more information about capturing and recording videos to DVDs or CDs from an analog video camera.

Recording a digital video file
Refer to “Identifying Requirements for Capturing Video with WinDVD Creator” on page 79 and “Capturing Digital Camcorder Video with WinDVD Creator” on page 79 for more information about recording videos to DVDs or CDs from a digital camera.

Creating a CD/DVD from Video Files
To create a CD/DVD from your videos:

1. Press the Media Center Start button on the remote control.
2. Select More Programs.
3. Insert writable disc (CD-R, CD-RW, DVD+R, or DVD+RW), and then select OK.
4. Select Create CD/DVD.
5. Select the Untitled area and enter the name of your disc by using the numeric keys on the remote control, and then select OK. Use the Clear button to delete letters.
6. Use the arrow buttons on the remote control to select Video, and then select OK.
7. Select the video file you want to copy, and then select View CD/View DVD.
8. Select Add More if you want to add additional video files to your disc.
9. Select View CD/View DVD to check the contents of your disc before recording them.
10. Select Create CD/Create DVD to begin recording the disc, and then select Yes.
Playing DVDs

Watching DVDs in Media Center allows you to control the playback with your remote control. If you play your DVD in another program outside of Media Center, you will not be able to use the remote control.

Playing DVD movies in Media Center

1. Press the Media Center Start button on the remote control.
2. Insert the DVD into the drive. If you have other media playing, Media Center asks if you want to play the DVD. Select Yes or No. If you don’t select an option, the DVD autoplays in full-screen mode after a few seconds.
   
   Or

   If the DVD is already in the drive, select Play DVD from the main start menu. The DVD movie begins playing in full-screen mode.

3. If a DVD menu appears, use the remote control or the mouse to select the DVD menu items and control the DVD movie playback.
4. To stop playing the DVD, press Stop on the remote control.
5. To change the window size while the DVD movie is playing, move the mouse for the Resize icon to appear.
6. Click the Resize icon on the taskbar, and then you can manually adjust the window size.

To view more information about a DVD that you are watching, such as the DVD title, chapter title, genre, parental rating, length and current position, press the More information button on the remote control.
Changing the DVD Movie Language

To select DVD language settings for subtitles, closed captioning, and viewing the DVD:

1. In the Media Center Start menu, select Settings.
2. In the Settings window, select DVD.
3. In the DVD Settings window, select Language.
4. Use the arrow buttons on the remote control to select (+) or (−). Press OK on the remote control to scroll through the languages available.
5. When you find the one you want, use the arrow buttons to select Save, and then press OK on the remote control.
6. To return to the main Settings window, press the Back button.

Changing DVD Audio Settings

To select DVD audio settings for viewing the DVD:

1. Press the Media Center Start button on the remote control.
2. Select Settings.
3. Select DVD.
5. Using your mouse or keyboard, select your speaker and sound options, and then click OK.
If your PC is equipped with a radio tuner input (FM), then Media Center can play FM radio. The Radio window in Media Center makes it easy to play FM radio stations using your remote control.

In Radio you can:

- Listen to FM radio stations.
- Set up pre-sets of your favorite radio stations.
- Delete or organize your radio station pre-sets.
- Use the time-shifting feature; pause, rewind, and fast-forward up to 30 minutes of radio programs.

Make sure you connect the FM radio antenna to the back of the PC before selecting an FM radio station. This antenna is for select models only.
Playing FM Radio Stations

1. Connect the FM radio antenna to the back of the PC to the connector labeled FM.

2. Press the Media Center Start button on the remote control.


4. Enter a radio station number by using the numeric keypad on the remote control or your keyboard.

   Or

   Select the Seek (–) or (+) buttons for Media Center to find the next playable station.

   Or

   Select the Tune (–) or (+) buttons to manually find a station.

5. If you want, select Save to save it as one of your nine pre-set stations.

6. Select Start FM to begin playing that station.

7. Use the playback controls on the remote control, such as Pause, Rewind, and Fast-Forward to control radio playback. If you press the Pause button, Media Center continues to record the program for up to 30 minutes. Press Play to resume listening to the program where you left off.

8. Select Back to return to the previous window.
Organizing Pre-set Radio Stations

1. Press the Media Center Start button on the remote control.
2. Select **Settings**.
3. Select **Radio**.
4. Select the up arrows and down arrows next to each pre-set station to move it to a different position.
   Or
   Select the Delete icon (X) to delete a pre-set station.
   Or
   Select **Auto Sort** to sort your pre-set stations in numerical ascending or descending order.
5. Select **Save** to save your changes.
6. Select **Back** to return to the previous window.

Using the FM Radio and the TV Signal at the Same Time

In Media Center PCs, the FM radio signal and My TV input signal share a single tuner card. This means that you are unable to watch or record TV and listen to FM radio at the same time unless you have two TV tuners. When Media Center is scheduled to start a recording, a warning appears that says FM radio stops when the TV recording starts. If you do not select **Cancel recording**, then Media Center automatically stops radio and begins recording TV.
Creating (Burning) CDs and DVDs

You can make your own music or data CDs if your PC has a CD-RW or DVD Writer, or double-layer drive (select models only).

Your PC has four recording software programs: iTunes, Windows Media Player, RecordNow!, and Windows XP. You copy or download music to their library and can then organize or copy the music files. You can copy Windows Media files that have a .wma extension, .mp3 files, or .wav files to a CD by using a CD-RW drive or a DVD Writer drive. You can also use iTunes or Windows Media Player to copy music files to a portable device or memory card.

CD-R discs are compatible with more players than CD-RW discs.

Creating (Burning) CDs and DVDs with RecordNow!

For more information about recording CDs and DVDs, refer to the Help menu in the RecordNow! software program.

Previously recorded files on CD-RW discs must be erased before recording music files. CD-R discs cannot be erased.

1. Using the mouse, click Start on the Windows taskbar.
2. Choose All Programs.
3. Click Sonic RecordNow!, and then click RecordNow! again.
4. If you need to erase a disc (CD-RW or DVD+RW): Insert the disc, select the Home screen (house icon) tab, and then Erase Disc under the Home Screen tab.

Creating music CDs with RecordNow!

RecordNow! creates closed-session music CDs, which means you must record all music files on one CD in one recording session. Music files can be recorded repeatedly on a rewritable CD-RW disc, but all previously recorded files must be erased first. CD-R discs cannot be erased.

CD-R discs play in most home and car stereos. CD-RW discs play only in some stereos.

You can use RecordNow! to create audio CDs to play in your car or home CD player, or on your PC.

Burn is an industry term used to describe the recording of information onto a DVD or CD. Optical recording uses a laser beam to place information onto the disc, thus the term burning.

If your recording fails, manually select a slower recording speed, if available, each time you make a recording. Refer to the Help menu in your selected software program for more information about selecting a slower recording speed.

IMPORTANT: HP supports the lawful use of technology and does not endorse or encourage the use of our products for purposes other than those permitted by copyright law.
Creating CDs to play in your car or home CD players

1. Using the mouse, click **Start**, choose **All Programs**, **Sonic RecordNow!**, and then click **RecordNow!** again.

2. Select the **Audio Projects** tab.

3. Select **Audio CD for Car or Home CD Player**.

4. Insert a music CD to view the tracks on your CD. Select **View** if you would like to look at another optical drive.

   Or

   Click **Find**, and then click either **Scan for Music** or **Browse** to find music files on your hard disk drive that you want to record.

5. Select the tracks you want to record, and then click **Add**.

6. Click the **Burn** icon when you have added all the audio files to your music CD project.

7. Click **Yes**.

8. When prompted, insert a blank CD-R or CD-RW disc. If you want to play your music CD in your home or car stereo, use a CD-R disc. CD-RW discs may not play in some stereos.

9. Click **OK**. It is best not to use the PC while recording.

10. Click **Done** when recording is complete.

   Click the **Help** icon, and then select **RecordNow! Help** for more information about recording music CDs with the RecordNow! program.

---

Creating CDs to play on your PC

1. Using the mouse, click **Start**, choose **All Programs**, **Sonic RecordNow!**, and then click **RecordNow!** again.

2. Click the **Audio Projects** tab.

3. Select **Jukebox CD**.

4. Insert a music CD to view the tracks on your CD. Click **Find**, and then click either **Scan for Music** or **Browse** to find music files on your hard disk drive that you want to record.

5. Select the tracks you want to record, and then click **Add**. Press and hold the Control (Ctrl) key to select more than one track.

6. Click the **Burn** icon when you have added all the audio files to your music CD project.

7. Click **Yes**.

8. When prompted, insert a blank CD-R or CD-RW disc. If the CD-RW disc is not blank, RecordNow! prompts you to erase it and then automatically begins writing to it when it is erased. If you want to play your music CD in your home or car stereo, use a CD-R disc. CD-RW discs may not play in some stereos.

9. Click **OK**. It is best not to use the PC while recording.

10. Click **Done** when recording is complete.

   Click the **Help** icon, and then select **RecordNow! Help** for more information about recording music CDs with the RecordNow! program.
**Creating a music CD**

When recording music files, it is important to note that:

- To play your music CD in a home or car stereo, it needs to be recorded as a music CD in CD Audio (CDA) format, not as a data CD.
- You must record all music files in one recording session because RecordNow! closes the CD after recording is complete. Music files can be recorded repeatedly onto a rewritable (CD-RW) disc, but all previously recorded music files must be erased first.
- As you add music files in the recording session, RecordNow! calculates and displays the amount of recording time available to record additional music files.
- You can’t record song titles unless you make an exact copy of a music CD in your collection.
- If you try to record more than a standard CD can hold, RecordNow! displays a message warning you that all the tracks may not fit on your disc.

**Storing Files on a DVD or CD**

Unlike music CDs, data DVDs and CDs can be recorded in multiple sessions:

1. Using the mouse, click **Start**, choose **All Programs**, **Sonic RecordNow!**, and then click **RecordNow!** again.
2. Select the **Data Projects** tab.
3. Insert a blank or appendable CD-R, CD-RW, DVD+R, DVD+RW, or double-layer DVD+R (select models only) disc into your drive, and then click **Data Disc**.

- If the disc is full, insert a blank or another appendable disc.
- If you are adding files to a disc, follow the onscreen instructions.

4. To name your disc, select **Volume Label**, and then type a name over it. RecordNow! assigns a name based on the recording date if you don’t type a name.
5 Add your data files to the file selection window:

- Click the Add Files and Folders button, find and select your folders and files, and then click Add. Repeat this step until all files are added.

Or

- Drag your file from your desktop or from anywhere in Windows Explorer into the file selection window. Repeat this step until all files are added.

6 Click the Burn icon when all of your files have been added.

7 Click Done when recording is complete.

Click the Help icon, and then click RecordNow! Help for more information about recording data files with the RecordNow! program.

---

**Storing data files on disc**

When storing data files on a disc, it is important to note that:

- You can add new data files to a CD-R and a DVD+R in a later recording session, until the disc is full. With DVD+R discs, you need to select the correct setting in RecordNow! to record files in a later session. To do this, insert your recorded DVD, open RecordNow!, click the Options icon (wrench), click Data, select the recording option you want, and then click OK.

- When you record files that have the same name as previously recorded files, RecordNow! updates the file and the previous version is overwritten.

- RecordNow! allows you to change the names of files you want to record and the files that were previously recorded.

- As you select data files to record to your disc, RecordNow! calculates and displays the amount of recording space used on your disc.
Copying a DVD or CD

RecordNow! allows you to make a copy of a music or data disc from your collection.

To make a copy of a music or data disc from your collection:

1. Using the mouse, click Start, choose All Programs, Sonic RecordNow!, and then click RecordNow! again.
2. Select the Data Projects tab.
3. Select Exact Copy.
4. Insert the CD or DVD you want to copy.
5. Click the Copy icon.
6. Insert a blank DVD or CD into the drive, and then click OK.
7. Click Done when the recording is complete.

Archiving Files on a CD or DVD

1. Using the mouse, click Start, choose All Programs, Sonic RecordNow!, and then click RecordNow! again.
2. Select the Backup Projects tab.
3. Select File Archive.
4. Insert a blank CD or DVD into the drive.
5. Place a check mark in the Changed since box to limit the scan to files that have been changed since the last time you completed a file archive.
6. Add your files to the Archive window:
   - Select one or more categories from the list on the left, and click Scan. RecordNow! scans your hard disk drive for files related to the category.
   - Drag files from the Windows Explorer to the Archive window.
7. Click the Burn icon when all of your files have been added.
   - If the files do not fit on one disc, File Archive asks you for additional discs.
8. Click Done when recording is complete.

Recording Video Files

Video quality depends on the quality of the source files, the PC speed, and its graphics processing ability. For more information about recording VHS files to DVD, refer to “Recording VHS Files Direct to DVD with WinDVD Creator” on page 85.
Using Disc Labels

⚠️ WARNING: When labeling your DVDs, do not use sticky labels. They can cause the DVD to play erratically. Instead, write on the DVD with a felt-tip pen to label it.

Creating Recovery CDs/DVDs for the PC

For more information about creating Recovery CDs/DVDs, refer to the Warranty and Support Guide that came with your PC.

Using Compatibility Information

An important feature of a DVD Writer/CD Writer drive is its high level of compatibility with other optical drives and CD and DVD players:

- The CDs that you create play in most home and car stereos and in most computer DVD-ROM and CD-ROM drives.
- The DVDs that you create are compatible with some DVD video players and with most computer DVD-ROM drives.
- CD-R discs are compatible with more home and car stereos than CD-RW discs are.

Your DVD Writer/CD Writer drive is able to read from and record to almost every type of optical disc. Writing speed rates for the DVD Writer/CD Writer drive are fast, allowing quick recording times.

Understanding video recording lengths and video quality settings

<table>
<thead>
<tr>
<th>Video quality setting</th>
<th>Bit rate</th>
<th>GB/Hour</th>
<th>Minutes on a 4.7 GB DVD</th>
<th>Minutes on a 8.56 GB DVD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fair</td>
<td>2,884,000</td>
<td>1.2</td>
<td>170 minutes *</td>
<td>300 minutes *</td>
</tr>
<tr>
<td>Good</td>
<td>3,384,000</td>
<td>1.4</td>
<td>145 minutes *</td>
<td>260 minutes *</td>
</tr>
<tr>
<td>Better</td>
<td>4,884,000</td>
<td>2.0</td>
<td>100 minutes *</td>
<td>185 minutes *</td>
</tr>
<tr>
<td>Best</td>
<td>6,384,000</td>
<td>2.7</td>
<td>80 minutes *</td>
<td>144 minutes *</td>
</tr>
</tbody>
</table>

* Minutes listed are approximate and not exact.
## Identifying Disc Feature and Compatibility

<table>
<thead>
<tr>
<th>Disc</th>
<th>File type</th>
<th>Can be recorded onto</th>
<th>Plays in PC</th>
<th>Plays in home or car stereo</th>
<th>Plays in home DVD player</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CD-ROM</strong></td>
<td>Data</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Music</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Varies by model</td>
</tr>
<tr>
<td><strong>CD-R</strong></td>
<td>Data</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>MP3 music</td>
<td>Yes</td>
<td>Yes</td>
<td>Varies by model</td>
<td>Varies by model</td>
</tr>
<tr>
<td><strong>CD-RW</strong></td>
<td>Data</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>MP3 music</td>
<td>Yes</td>
<td>Yes</td>
<td>Varies by model</td>
<td>Varies by model</td>
</tr>
<tr>
<td><strong>DVD-ROM</strong></td>
<td>Data</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>DVD movie</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>DVD+R</strong></td>
<td>Data</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>DVD movie</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Varies by model</td>
</tr>
<tr>
<td><strong>Double-layer DVD+R</strong></td>
<td>Data</td>
<td>Yes</td>
<td>Varies by model</td>
<td>No</td>
<td>Varies by model</td>
</tr>
<tr>
<td></td>
<td>DVD movie</td>
<td>Yes</td>
<td>Varies by model</td>
<td>No</td>
<td>Varies by model</td>
</tr>
<tr>
<td><strong>DVD+RW</strong></td>
<td>Data</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>DVD movie</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Varies by model</td>
</tr>
<tr>
<td><strong>VCD</strong></td>
<td>DVD movie</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>Varies by model</td>
</tr>
</tbody>
</table>

**NOTE:** This PC comes with the Double-Layer DVD Writer. It supports single-layer and double-layer DVD media. Double-layer technology gives you greater capacity and allows you to store up to 8.5 GB* of data on double-layer DVD+R media.

Double-layer is a new technology. Double-layer media compatibility will vary widely with some home DVD players and DVD-ROM drives.

*GB is defined as 1 billion bytes. 1 GB = 1 billion bytes when referring to hard disk drive capacity. Actual formatted capacity is less.

For the latest disc compatibility information for your PC, go to the HP Support Web site: [http://www.hp.com/support](http://www.hp.com/support)

Double-layer DVD technology is supported by select models only.

The InterVideo WinDVD Creator and RecordNow! recording programs support the double-layer technology.
## Using the Optical Drive Quick Reference Table

<table>
<thead>
<tr>
<th>Optical drive can</th>
<th>CD-ROM</th>
<th>CD-RW</th>
<th>DVD-ROM</th>
<th>DVD+RW/+R</th>
<th>Double-layer</th>
<th>Combo CD-RW/DVD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read CDs, CD-Rs, and CD-RWs</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Read DVDs</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Read data on a CD</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Play music</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Record data or music to disc for storage or backup</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>View DVD movies</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Record DVD movies</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Play PC games</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Using the Software Quick Reference Table

To open software programs you can use with various media and an optical drive, click **Start** on the taskbar, choose **All Programs**, select the program folder, and then click the program to open the software. Refer to the following table to determine the best programs for the tasks you want to do.

Your PC comes with the following software programs. Use this table to find out what you can do within each program. Some programs listed below may not be included with your PC model.

You may have a software update CD included with your PC. You may need to install this CD before using the DVD Writer/CD Writer drive. To do this, follow the installation instructions that came with the CD.

<table>
<thead>
<tr>
<th>Software</th>
<th>With this program you can</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>iTunes</strong></td>
<td>■ Play music CDs, MP3s, and other audio files.</td>
</tr>
<tr>
<td></td>
<td>■ Record music files.</td>
</tr>
<tr>
<td></td>
<td>■ Record a copy of an existing music or data CD to use on the PC.</td>
</tr>
<tr>
<td></td>
<td>■ Organize digital files into a library for recording or listening.</td>
</tr>
<tr>
<td><strong>Windows Media Player</strong></td>
<td>■ Play music CDs, MP3s, and other audio files.</td>
</tr>
<tr>
<td></td>
<td>■ Play DVD movies. (Windows Media Player can play DVDs only if another DVD player program, such as InterVideo WinDVD, is installed.)</td>
</tr>
<tr>
<td></td>
<td>■ Play Windows Movie Maker files.</td>
</tr>
<tr>
<td></td>
<td>■ Record music files.</td>
</tr>
<tr>
<td></td>
<td>■ Organize digital files into a library for recording or listening.</td>
</tr>
<tr>
<td><strong>RealPlayer</strong></td>
<td>■ Play music CDs, MP3s, and other audio files.</td>
</tr>
<tr>
<td></td>
<td>■ Play DVD movies. (RealPlayer can play DVDs only if another DVD player program, such as InterVideo WinDVD, is installed.)</td>
</tr>
<tr>
<td></td>
<td>■ Play video CDs.</td>
</tr>
<tr>
<td></td>
<td>■ Record music files.</td>
</tr>
<tr>
<td></td>
<td>■ Organize digital files into a library for recording or listening.</td>
</tr>
<tr>
<td>Software</td>
<td>With this program you can</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Windows Movie Maker 2.0 | ■ Import audio, video, and other media files from a videotape, an audiotape, a Web camera, or a television broadcast.  
 ■ Record audio and video files to create a video project that becomes a Windows Media source file with a .wmv extension.  
 ■ Edit and preview files.  
 ■ Send a movie in an e-mail or upload it to a Web server.  
 ■ Add music files (.mp3).  
 ■ Import audio files such as .mp3, .asf, or .wma; video files such as .wmv, .asf, .avi, or .mpg; or image files such as .jpg or .gif.  
 ■ Create .avi and .wmv (Windows Media Video) files. |
| InterVideo WinDVD | ■ Play DVD movies and video CDs (VCDs).                                                   |
| RecordNow!     | ■ Record data and music files.                                                            |
|               | ■ Record a copy of an existing music or data CD to use on the PC.                         |
|               | ■ Create customized music CDs from CDs in your collection, or from .wav, .mp3, or .wma files. These CDs can be played in your home or car stereo. |
|               | ■ Copy and share data files.                                                              |
|               | ■ Copy short video files.                                                                 |

Video files recorded with RecordNow! can be viewed on a PC but not on home DVD video players.
<table>
<thead>
<tr>
<th>Software</th>
<th>With this program you can</th>
</tr>
</thead>
<tbody>
<tr>
<td>InterVideo WinDVD Creator</td>
<td>■ Capture digital and analog video files directly from a digital video (DV) camera, VCR, or other analog capture device.</td>
</tr>
<tr>
<td></td>
<td>■ Assemble movies by capturing video clips and scenes into a video project.</td>
</tr>
<tr>
<td></td>
<td>■ Edit your movies. Cut scenes and add music and sound effects, still images, text, video transitions, and voice-overs.</td>
</tr>
<tr>
<td></td>
<td>■ Preview movies during editing and before recording final files.</td>
</tr>
<tr>
<td></td>
<td>■ Create video files, export them to your hard disk drive or your digital video camera, and then play them on your PC.</td>
</tr>
<tr>
<td></td>
<td>■ Create video files, record them to DVDs and CDs, and then play them on some set-top DVD players.</td>
</tr>
<tr>
<td></td>
<td>■ Record video files to 7 different formats.</td>
</tr>
<tr>
<td>muvee autoProducer unPlugged</td>
<td>■ Add your own style to your movies with music, pictures, titles, scene transitions, and captions.</td>
</tr>
<tr>
<td></td>
<td>■ Edit your home movies.</td>
</tr>
</tbody>
</table>

The muvee autoProducer unPlugged video editing program is for select models only.
Importing, Editing, and Burning Videos

You can capture, edit, and record your home movies in a few easy steps by using the InterVideo WinDVD Creator program located in your All Programs folder on your desktop. You can also use the muvee autoProducer unPlugged program (select models only) to personalize your video files from within Media Center by using your remote control.

Both programs allow you to edit your video files and save your files to your hard disk drive. You need to use InterVideo WinDVD Creator to capture your video files from a video device and also to record your video file to a disc. If you use muvee autoProducer to create your video file, you can use WinDVD Creator to record it to disc.

For instructions on how to use InterVideo WinDVD Creator to create your own personalized video file, see the following description and see “Getting started with WinDVD Creator” on page 78.

For instructions on how to use muvee autoProducer to create your own personalized video files, see the following description and see “Getting Started with muvee autoProducer” on page 85.

Using InterVideo WinDVD Creator

You can use InterVideo WinDVD Creator to create your personalized video files in a few easy steps.

Capture: Take videos and pictures from digital camcorders, analog video devices, and Web cameras, and then save them to your hard disk drive.

Edit: Arrange and trim your files. Add titles, transition effects, images, and audio.

Add Menu: Add a menu with chapters to your DVD.

Make Movie: Finalize your project by burning your movie to your hard disk drive or to disc.

For more information about WinDVD Creator, click the Help menu in the WinDVD Creator menu bar.

Using muvee autoProducer unPlugged

(Select models only)

You can use muvee autoProducer to create your personalized video files in a few easy steps. You can access muvee autoProducer in Media Center under More Programs.

You must capture digital video files to your hard disk drive and burn your movies to disc using the InterVideo WinDVD Creator program. The basic steps when using muvee autoProducer are:

- Add videos and pictures: Select video and picture files on your PC.
- Add music: Select music files on your PC to add to your movie.
- Select a style: Apply a movie style for a different effect and picture transition.
- Make the movie: Combine your pictures, music, and styles to your movie and save your movie to your hard disk drive.

For more information about muvee autoProducer, click the ? in the muvee autoProducer menu bar.
Getting started with WinDVD Creator

1 Click Start, choose All Programs, InterVideo WinDVD, InterVideo WinDVD Creator, and then click InterVideo WinDVD Creator again.

2 Select one of the menu options:

- **Capture video into hard disk:** Opens the Capture section for you to capture media.
- **Create CD/DVD with existing video file:** Brings up the Open window for you to select existing video files.
- **Record video tape into DVD disc in one step:** Enables you to bypass the hard disk drive and record straight from your camera to a disc in your DVD drive.
- **Open existing project:** Brings up the Open window for you to select an existing project.
- **Create new project:** Opens the Edit section for you to begin creating a new project.

Using the Preview window in WinDVD Creator

The Preview window is located in the upper-left corner and behaves differently for each task.

**Capture:** Displays what your capture device is viewing.

**Edit:** Plays back the selected video or displays the selected image.

**Add Menu:** Displays what your menu and buttons look like.

Using the Media Library in WinDVD Creator

The Media Library contains your video clips, images, and audio tracks. To import existing media files from your hard disk or CDs into the Media Library, click the Drag and Drop button.

**Capture:** Located in bottom right corner. Contains your video clips, images, and audio tracks.

**Edit:** Located in upper-right corner. Contains your video clips, images, and audio tracks.

**Add Menu:** Located in upper-right corner. Contains menu themes, video backgrounds, audio tracks, images, buttons, chapter layouts, and chapter thumbnails.

Using the Storyboard in WinDVD Creator

Located on the bottom of the Edit and Add Menu area. The Storyboard can be displayed in either Menu Picker or Timeline mode. Use the Storyboard to organize your media and add special effects such as titles, transition effects, audio tracks, and video filters.
Identifying Requirements for Capturing Video with WinDVD Creator

You can copy (capture) video files to your hard disk drive by using the WinDVD Creator program.

To capture digital video, connect your digital video (DV) camera to the FireWire® (IEEE 1394) port on the front panel of the PC. To capture analog video, connect your VCR or analog video camera to the Composite Video 2 or S-Video 2 connectors on the front panel of the PC.

To capture video files, you need to:

1. Connect your video source device properly.
2. Turn your device on and set it to playback mode.
3. Make sure WinDVD Creator can detect your digital or analog device.
4. If your PC has multiple video devices connected, they all appear on the Capture screen. You must select the video source you would like to use.
   a. In the WinDVD Creator Capture screen, click your input source.
   b. Click the Wrench icon.
   c. Select Device Control tab, and then select your video source from the Video Source drop-down menu.

Capturing Digital Camcorder Video with WinDVD Creator

1. Click Start, choose All Programs, InterVideo WinDVD, InterVideo WinDVD Creator, and then click InterVideo WinDVD Creator again.
2. Click the Capture video into hard disk button.
3. Connect your digital camcorder to your PC.
4. Make sure the output from your digital camcorder appears in the Preview window. If it does not, double-check your connections and make sure your camera is in playback mode.
5. Click the Play button to preview your video file before you record it.
6. Find your starting point in the video, and click the Pause button.
7. Click the Record button.
8. Enter a file name, click Save, and recording begins.
9. Click the Stop button to stop capturing your video file. Your video file is processed and automatically saved to the My Videos folder on your hard disk drive. The video clip appears in the Media Library portion of the screen.
10. To play back your captured video, click the file in the Media Library, and click the Play button in the Preview window.
Capturing Analog Video with WinDVD Creator

1. Click Start, choose All Programs, InterVideo WinDVD, InterVideo WinDVD Creator, and then click InterVideo WinDVD Creator again.

2. Click the Capture video into hard disk button.

3. Connect your VCR, television, or other analog input device to the Composite Video 2 or S-Video 2 connector on the front panel of the PC.

4. Connect the Audio L and R connectors of your analog input device to the Audio L and R connectors on the front panel of the PC. Make sure the Capture button is selected.

5. Click the Wrench icon, and then select the Device Control tab.

6. Click the Video Source drop-down box, and then select either S-Video 2 or Composite Video 2, depending on which front panel connector you are using.

7. Click OK. Your video appears in the Preview window. To begin capturing the video, click the Record button.

8. Enter a file name, and then click Save, and recording begins.

9. Click the Stop button to stop capturing your video file. Your video file is processed and automatically saved to your hard disk drive.

10. To play back your captured video, double-click the file.
Editing Video Files with WinDVD Creator

After you capture video files, use the WinDVD Creator Edit module to create your customized video file. In the edit mode you can add:

- Video files
- Still images
- Audio and music tracks
- Transition effects
- Video filters
- Title effects

To edit your video files:

1. If your project is already open, click the Edit button and skip to step 4.

2. Click Start, choose All Programs, InterVideo WinDVD, InterVideo WinDVD Creator, and then click InterVideo WinDVD Creator again.

3. Open a project by selecting either the Create new project or the Open existing project button.

4. If you have already captured video for this project, drag and drop the video files from the Media Library to the Storyboard. If you have video files on your hard disk drive you would like to add to this project, click Drag and Drop.

5. If you do not like the sequence of the video files, drag and drop the files in the Storyboard to change the sequence.
Adding images with WinDVD Creator

1. Click the Image Library icon.
2. Click the Drag and Drop button to open the My Pictures folder on your hard disk drive.
3. Select the images from your hard disk drive you would like to add to your Image Library, and click Open.
4. Drag and drop images from the Image Library to your Storyboard.

Now you can edit still images and video files. See the following table.

<table>
<thead>
<tr>
<th>Storyboard icons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>Groups multiple images into one on the Storyboard.</td>
</tr>
<tr>
<td>Expand</td>
<td>Expands grouped images so they are all displayed on the Storyboard.</td>
</tr>
<tr>
<td>Save Movie</td>
<td>Records output directly to a DV camcorder or writes output to a file in your selected format.</td>
</tr>
<tr>
<td>Edit Clip</td>
<td>Trims a video clip:</td>
</tr>
<tr>
<td></td>
<td>1. Double-click a video clip on the Storyboard.</td>
</tr>
<tr>
<td></td>
<td>2. Adjust the sliders to cut off video at the beginning or the end.</td>
</tr>
<tr>
<td>Split Clip</td>
<td>Splits a video clip:</td>
</tr>
<tr>
<td></td>
<td>1. Click the video clip you want to split.</td>
</tr>
<tr>
<td></td>
<td>2. Click the Play button in the Preview window.</td>
</tr>
<tr>
<td></td>
<td>3. Click the Split Clip icon at the point of the clip you want split.</td>
</tr>
</tbody>
</table>

Adding audio effects with WinDVD Creator

1. Click the Audio Library icon.
2. Click the Drag and Drop button to open the My Music folder on your hard disk drive.
3. Select the audio files from your hard disk drive you want to add to your audio library, and click Open.
4. Drag and drop the audio files from the Audio Library to the video file of your choice.
5. A musical note icon appears in the bottom right corner of the video file to which the audio track was assigned.
6. To keep the audio track running for more than one video file, switch from Storyboard mode to Timeline mode. Drag the music track across more than one video file.
Adding transition effects with WinDVD Creator

1. Click the Transition Effects icon.
2. Drag and drop a transition effect between the two video files, where you would like the effect to appear.

Adding title effects with WinDVD Creator

1. Click the Title Effects icon.
2. Drag and drop a title effect either between video files or to a video file on the Storyboard.
3. Type the text you would like to appear on your title screen.
4. If you inserted the title effect between video clips, click the Image Setting icon to adjust the length of time you want the title clip to appear. A capital T appears in the bottom-right corner of the title clip on the Storyboard.

Adding video filters with WinDVD Creator

1. Click the Video Filters icon.
2. Drag and drop a video filter to the video of your choice.

Authoring Your DVD with WinDVD Creator

The Add Menu section makes your project interactive by creating a menu theme and by breaking it into chapters. The menu theme can be your own images and music or a custom theme that comes with WinDVD Creator.

1. If your project is already open, click the Add Menu button.
2. Click Start, choose All Programs, InterVideo WinDVD, InterVideo WinDVD Creator, and then click InterVideo WinDVD Creator again.
3. Select the Open existing project button, and then select your project.
4. Click the Add Menu button.
5. Click the Media Library icons to add a menu theme, chapters, buttons, audio tracks, and images to your DVD.
6. Click the Storyboard icons to edit the chapters and menu items.
7. Click the Preview button to play your DVD as it will appear in a set-top player.
Making a movie with WinDVD Creator

This is the final step of your DVD project. You select a format, the type of TV system, and volume name.

1. If your project is already open, click the Make Movie button and skip to step 5.

2. Click Start, choose All Programs, InterVideo WinDVD, InterVideo WinDVD Creator, and then click InterVideo WinDVD Creator again.

3. Select the Open existing project button, and then select your project.

4. Click the Make Movie button.

5. Insert a blank recordable DVD or CD into your drive.

6. Choose one from each of the following sections (order of selections may differ).

<table>
<thead>
<tr>
<th>Select Device</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Burn to Disc</td>
<td>Use this to burn directly to a DVD or CD.</td>
</tr>
<tr>
<td>Write content to hard disk for later burning</td>
<td>Use this to create the file on your hard disk drive.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Select</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>TV System</td>
<td>Select between NTSC and PAL for your TV system. The NTSC format is used in North America, and the PAL format is used in European and Asian countries/regions.</td>
</tr>
<tr>
<td>Format</td>
<td>Select one of the formats to record your project.</td>
</tr>
<tr>
<td>Volume Name of Disc</td>
<td>Enter a Volume name for your disc (optional).</td>
</tr>
</tbody>
</table>

7. Click the right arrow, and then click Start.

8. Click OK.
Recording VHS Files Direct to DVD with WinDVD Creator

To record VHS or other video files directly to DVDs:

1. Connect your VCR or other analog video source to your computer. See “Capturing Analog Video with WinDVD Creator” on page 80 for more information about capturing analog video.

2. Click Start, choose All Programs, InterVideo WinDVD, InterVideo WinDVD Creator, and then click InterVideo WinDVD Creator again.

3. Select the Record video tape into DVD disc in one step button.

4. Insert a blank DVD into your drive.

5. Click the Capture button, and select your VCR on the Device Control tab.

6. Press the Playback button on your VCR.

7. Click the Record button when the Preview window displays what you want to record.

Getting Started with muvee autoProducer

(Select Models Only)

You can use muvee autoProducer to create your personalized video files in a few easy steps:

1. Press the Media Center Start button on the remote control to open Media Center.

2. Select More Programs, and then select the Make muvee icon.

3. Select one of the button options:

   - Select Video: Opens the Select Video window for you to select existing video files.
   - Select Pictures: Opens the Select Pictures window for you to select existing image files.
   - Select Music: Opens the Select Music window for you to select existing music files.
   - Select Style: Opens the Select Style window for you to select a style template for your movie.
   - Settings: Opens the Settings window for your to set the audio mix for your movie.
   - Make muvee: Opens the Make muvee window for you to set the duration of your movie and automatically create the movie.

IMPORTANT: HP supports the lawful use of technology and does not endorse or encourage the use of our products for purposes other than those permitted by copyright law.
Adding Videos to Your Movie with muvee autoProducer

It is easy to add video files to your muvee production. The following formats are supported:

- Video — .dv, .avi, .mpeg-1, .mpeg-2

1. If your project is already open, select the Select Video button and skip to step 4.
2. Press the Media Center Start button on the remote control to open Media Center.
3. Select More Programs, and then select the Make muvee icon.
4. Select the video files under My Videos to add to your Selected Videos.
5. Adjust the order of the videos by using the Move Up and Down buttons.
6. Select Next when you are finished adding videos to your movie project.

Adding Pictures to Your Movie with muvee autoProducer

It is easy to add still image files to your muvee production. The following formats are supported:

- Pictures — .bmp, .jpg, .jpeg, .gif

1. If your project is already open, select the Select Pictures button and skip to step 4.
2. Press the Media Center Start button on the remote control to open Media Center.
3. Select More Programs, and then select the Make muvee icon.
4. Select the images under My Pictures to add to your Selected Pictures.
5. Adjust the order of the images by using the Move Up and Down buttons.
6. Select Next when you are finished adding pictures to your movie project.
Adding Music to Your Movie with muvee autoProducer

You can use .mp3, .wav, or .wma formatted music files in your movie project.

You can also choose whether to use the original sound track from your video, blend the sound track with your music selections, or just use the selected music files:

1. If your project is already open, select the Select Music button and skip to step 4.
2. Press the Media Center Start button on the remote control to open Media Center.
3. Select More Programs, and then select the Make muvee icon.
4. Select the music files under My Music to add to your Selected Music.
5. Adjust the order of the music by using the Move Up and Down buttons.
6. Select Next when you are finished adding pictures to your movie project.

Setting the Style in muvee autoProducer

The muvee autoProducer program comes with a set of style templates for setting the pace, scene transition effects, and caption fonts. The style you use also affects how muvee autoProducer combines the video, picture, and music files in your movie project to produce the final movie.

For example, using the Cinema style results in a movie that is moderately paced, color enhanced, and uses a wide-screen format.

1. If your project is already open, select the Select Style button and skip to step 4.
2. Press the Media Center Start button on the remote control to open Media Center.
3. Select More Programs, and then select the Make muvee icon.
4. Select a style from the list of ten. A description of the style displays in the window.
5. Select Next when you are finished adding pictures to your movie project.
Changing the Settings in muvee autoProducer

After you have added at least one video or picture file to your movie project, you can adjust the audio settings.

1. If your project is already open, select the Settings button and skip to step 4.
2. Press the Media Center Start button on the remote control to open Media Center.
3. Select More Programs, and then select the Make muvee icon.
4. Select the Sound Mix Level for the original sound track and the added music.
5. Check the Smart Join Multiple Music Clips box to cross-fade multiple music clips.
6. Check the Use Every Music Clip box to include all music files in your movie.
7. Select the Production button.
8. Select whether to have video, pictures and music to be repeated.
9. Select whether to keep the video and pictures in sequence.
10. Select the Next button to continue.

Making the Movie with muvee autoProducer

After you have added at least one video or picture file to your movie project, you can have muvee autoProducer make the movie.

The muvee autoProducer program makes a movie by combining the video, picture, and music files you have selected, along with the style of movie, and puts together all of these pieces into a professional-looking movie with just a few steps.

1. If your project is already open, select the make muvee button and skip to step 4.
2. Press the Media Center Start button on the remote control to open Media Center.
3. Select More Programs, and then select the Make muvee icon.
4. Select the duration for your movie by clicking either Use Automatic to allow muvee autoProducer to set the duration, or Set to for you to set the duration.
5. Select Next to start the process of creating your movie.
6. Preview the movie in the preview window. Use the playback controls under the preview window to play, pause, and stop the movie preview. Each time you make a change to a movie project, you need to click the make muvee button again to add that change to your movie.
Once you are satisfied with the look of your movie project, it is ready to be saved to your hard disk drive; select **Save**.

Select a format, such as MPEG2 or Windows Media Format by selecting the (+) or (−) buttons, and then enter a name for your movie by using the numeric keypad on your remote control.

Select **Continue** to save your movie. Your video project is saved to the My Videos folder on your hard disk drive by default. You can also access your video file in Media Center in the My Videos area.

Close muvee autoProducer and then press the Back button on your remote control. Select **My Videos** and then select your video to play it back in Media Center.

---

**Recording muvee autoProducer Movie to Disc with WinDVD Creator**

To create a VCD or DVD disc:

1. Using the mouse, click **Start**, choose **All Programs**, **InterVideo WinDVD**, **InterVideo WinDVD Creator**, and then click **InterVideo WinDVD Creator** again.
2. Select **Create CD/DVD with existing video file**.
3. Select your video file you created in muvee autoProducer, and then click **Open**.
4. Click the **Make Movie** tab, select **Burn to Disc**, and then select the **arrow button** to begin burning your movie to disc.
5. Follow the onscreen instructions.
Using an HP Personal Media Drive

The HP Personal Media Drive (sold separately) can be used as an internal or external USB hard disk drive designed to quickly and easily increase your storage capacity and to transfer media files such as digital photos, music, videos, and other important files from one PC to another. You can also use the HP Personal Media Drive to back up other drives on your PC.

The HP Personal Media drive is designed to:

- Work with the Media Center PC and other PCs that have a USB port.
- Store large media files and personal files.
- Transfer files between PCs.
- Play media files.
- Back up your files.

For more information about using your HP Personal Media Drive with Media Center, refer to the documentation on the HP Support Web site at:

http://www.hp.com/support
Setting Up the HP Personal Media Drive to Work with Media Center

When you complete this setup procedure, you will be able to easily access content, such as music, photos, videos, and recorded TV programs from customized folders on your HP Personal Media Drive.

Once you complete the setup wizard, you can drag and drop your music, video, pictures, and recorded TV files from your primary hard disk drive to personalized folders in the HP Personal Media Drive for backup or storage. You will also be able to use your remote control to access these files from within Media Center.

1. Insert the HP Personal Media Drive Installation CD that came with your HP Personal Media Drive.
2. When the menu of installation options appears, select the items you want to install by placing a check in the check box next to the choices. Make sure you place a check next to HP Media Center Setup Utility, and then click Install.
3. Insert your HP Personal Media Drive into the drive bay or connect it to a USB port, and then click Continue.
4. Follow any onscreen instructions and restart the PC when you complete the wizard.

Locating the Drive After Installation

After you install the HP Personal Media Drive into the PC, you can find the drive in My Computer. The PC automatically assigns a drive letter which may change unless you assign a drive letter. See “Assigning a Drive Letter to the HP Personal Media Drive” on page 93.

1. Click Start on the taskbar.
2. Click My Computer.
3. Select your drive under Hard Disk Drives. The default name is HP Personal Media Drive.
Assigning a Drive Letter to the HP Personal Media Drive

You can permanently assign a drive letter to avoid the letter changing when you connect and disconnect this drive and other devices. Also, it is easier for a software program to locate files on the HP Personal Media Drive if a drive letter is assigned. Some programs may not be able to find files if the drive changes letters every time you connect it.

To assign a drive letter:

1. Click **Start**.
2. Right-click **My Computer**.
3. Select **Manage**, and then click **Disk Management**.
4. Right-click **HP Personal Media Drive**.
5. Select **Change Drive Letter and Paths**. HP recommends that you pick the drive letter Z.
6. Click **Change** and select a letter, and then apply the changes by clicking **OK**.

Viewing and Storing Files

The best way to transfer files to the HP Personal Media Drive is to drag them from your local hard disk drive to your HP Personal Media Drive. If you want the files that are stored on your HP Personal Media Drive to appear in Media Center, you must drag them to the correct media folders, such as My Personal Videos and My Personal Pictures on your HP Personal Media Drive. These media folders appear after you complete the installation setup wizard that came on the HP Personal Media Drive Installation CD. See “Setting Up the HP Personal Media Drive to Work with Media Center” on page 92.

Playing Media Files

You can play all kinds of media from an HP Personal Media Drive:

1. Click **Start** on the taskbar.
2. Click **My Computer**.
3. Double-click the **HP Personal Media Drive** icon to locate your media file.
Playing Music Files

You can play all kinds of music stored on the HP Personal Media Drive. If you want the music files that are stored on your HP Personal Media Drive to appear in the Windows Media Player Library and the Media Center My Music window, you must create a link to this drive.

Playing music files with Windows Media Player

1. Click Start on the taskbar, click My Computer, and then double-click the HP Personal Media Drive icon.
2. Create a personal music folder by right-clicking in the folder and choosing New and then Folder. Type a name for your personal music folder.
3. Drag or copy your music files into this created folder.
4. Open Windows Media Player. Click Start, and then click Windows Media Player.
5. In the Windows Media Player window, click Tools, select Options, and then select the Library tab.
6. Click the Monitor Folders button.
7. Click Add to add a pathway to your HP Personal Media Drive.
8. Browse to locate your created music file folder on your HP Personal Media Drive, and then click OK.
9. Click OK, and then click OK again to close the Options window. Now your music files on your HP Personal Media Drive appear in the Windows Media Player Library and in the Media Center My Music window when your drive is connected to the PC.

When you disconnect the drive, your music files may still appear in the Windows Media Player Library and Media Center My Music window. To refresh your PC, open and close Windows Media Player or Media Center. If that doesn’t work, restart the PC.
Viewing Picture Files

You can view your pictures stored on an HP Personal Media Drive. If you want the picture files that are stored on your HP Personal Media Drive to appear in the Media Center My Pictures window, you must create a pathway to this drive.

To do this:

1. Click **Start** on the taskbar, click **My Computer**, and then double-click the **HP Personal Media Drive** icon.
2. Create a personal pictures folder by right-clicking in the folder and choosing **New** and then **Folder**. Type a name for your personal pictures folder.
3. Drag or copy your picture files into this created folder.
4. Open the My Pictures folder on your local hard disk drive by clicking **Start** and then **My Pictures**.

Playing Video Files

You can view your videos stored on an HP Personal Media Drive. If you want the video files that are stored on your HP Personal Media Drive to appear in the Media Center My Videos window, you must create a pathway to this drive.

To do this:

1. Click **Start** on the taskbar, click **My Computer**, and then double-click the **HP Personal Media Drive** icon.
2. Create a personal videos folder by right-clicking in the folder and choosing **New** and then **Folder**. Type a name for your personal videos folder.
3. Drag or copy your video files into this created folder.
4. Open the My Videos folder on your local hard disk drive by clicking **Start**, **My Documents**, and then double-clicking **My Videos**.
5. Right-click anywhere in the My Videos window, select **New**, and then select **Shortcut**.
6. When the Create Shortcut folder opens, click **Browse** and locate your personal videos folder, select the folder, and then click **OK**.
7. Click **Next**, and then click **Finish**. The shortcut to your personal video folder appears in the My Videos window.
8. Click **Add** to add a pathway to your HP Personal Media Drive. Now your video files on your HP Personal Media Drive appear in the Media Center My Videos window when your drive is connected to the PC.

When you disconnect the drive, your video files may still appear in the Media Center My Videos window. To refresh your PC, open and close Media Center.
Watching TV Programs Stored on the HP Personal Media Drive

To play back recorded TV files stored on your HP Personal Media Drive, you must:

1. Connect your HP Personal Media Drive to the PC with the PC turned off.
2. Turn on the PC and open Media Center.
3. Click Settings, TV, Recorder, Recorder storage.
4. Under Record on drive select the HP Personal Media Drive, select Save, and then select Yes. A Recorded TV folder is created and placed in your HP Personal Media Drive. Recorded TV shows must be placed in this folder to access them with Media Center.
5. Under Record on drive, select your local hard disk drive, select Save, and then select Yes.
6. Move or copy your recorded TV programs to this Recorded TV folder on your HP Personal Media Drive. Now you can view your stored TV programs in Media Center, or you can double-click the file and view the show in Windows Media Player.
7. Close Media Center before disconnecting the drive.

When you connect your drive, stored TV files appear in a few seconds after you open Media Center.

About Recording TV to the HP Personal Media Drive

The PC was set up to record TV shows to your local hard disk drive when using Media Center. It is possible to change the recording pathway to an HP Personal Media Drive, but several errors can occur if the drive is unexpectedly or improperly removed.

It is best to record TV shows to your local hard disk drive and then copy the files over to your HP Personal Media Drive.

If you decide to change your recording path to the HP Personal Media Drive, consider the following:

- The TV recording path does not default back to your local hard disk drive after the HP Personal Media drive is disconnected. This means that scheduled recordings may not be recorded. The recording error Low Disk Space may occur, and then your program will not be recorded. See “Changing Disk Allocation” on page 99 for more information about fixing this error.

- When the drive is disconnected, the disk allocation for Recorded TV shows reverts to 10%, and your recorded programs can be lost if you have selected the “Keep until space is needed” setting in My TV. See “Changing Disk Allocation” on page 99 for more information about changing the allocation.

You need to close Media Center before removing or before connecting your HP Personal Media Drive for the stored TV files to update properly.

HP recommends that you record TV programs directly to your local hard disk drive and then transfer the programs to the HP Personal Media Drive.

If you have problems recording after you have changed the recording pathway, close Media Center and then open it, and then restart the PC.
If you disconnect the drive while Live TV is active, a video error can occur.

■ Recorded TV shows are not updated in Media Center when the drive is removed.

■ The drive may be assigned a different drive letter, which prevents Media Center from recognizing the recording path or the stored Recorded TV files.

When you set the TV recording pathway to your HP Personal Media Drive, Media Center stores the recording buffer data for pausing live TV on your drive. This means that if live TV is playing, you won’t be able to remove the drive safely.

To avoid this scenario, change the recording pathway back to your local hard disk drive, and then restart the PC before disconnecting the HP Personal Media Drive.

---

**Recording TV programs to the HP Personal Media Drive**

1 Change your recording pathway to your HP Personal Media Drive. See “Changing the TV recording path to the HP Personal Media Drive” on page 98.

2 Open Media Center.

3 Record TV programs. See “Recording TV from the Guide” on page 22. Your programs are recorded to the HP Personal Media Drive.

4 Before disconnecting the drive:
   ■ Make sure there are no scheduled recordings or recordings in progress to avoid losing data.
   ■ Change the recording pathway back to your local hard disk drive. See “Changing the TV recording path to the local hard disk drive” on page 98.

5 Close Media Center.

6 Restart your PC. You must perform this last step, or errors can result when recording to your drive.

7 Disconnect your HP Personal Media Drive safely. See “Disconnecting the HP Personal Media Drive Safely” on page 99.
Changing the TV recording path to the HP Personal Media Drive

If you decide to change your recording path to record directly to your HP Personal Media Drive, Media Center creates a Recorded TV folder on your drive.

1. Assign a drive letter to your HP Personal Media Drive. See “Assigning a Drive Letter to the HP Personal Media Drive” on page 93.
2. Open Media Center.
3. Select Settings, TV, Recorder, and then Recorder storage.
4. Under Record on Drive, select (+) to select the HP Personal Media Drive. You can also set the disk allocation and recording quality settings in this window.
   HP recommends that you know the drive letter assigned and the storage amount of your HP Personal Media Drive.
5. Click Save, and then click Yes.
6. Close Media Center.
7. Restart the PC.

To change the TV recording path back to your local hard disk drive, follow this procedure and select your hard disk drive in step 4.

Changing the TV recording path to the local hard disk drive

To change the Media Center TV recording path to your local hard disk drive:

1. Open Media Center.
2. Select Settings, TV, Recorder, and then Recorder storage. You can also set the disk allocation and recording quality settings in this window.
3. Select your local hard disk drive (C:).
4. Click Save, and then click Yes.
5. Close Media Center.
6. Restart the PC.
Disconnecting the HP Personal Media Drive Safely

You can safely remove the drive when it is not active. When the amber activity light is blinking, the drive is active, saving or transferring data. Removing the drive while the light is blinking may cause data loss or damaged files.

To disconnect your HP Personal Drive safely:

1. Close Media Center and all other programs that may be accessing your HP Personal Media Drive. Make sure the activity LED is off.

2. Double-click the Safely Remove Hardware icon in the system tray at the bottom of the desktop. If this icon is hidden, click the arrows on the taskbar to display it. The Safely Remove Hardware window opens.

3. Double-click USB Mass Storage Device to locate your HP Personal Media Drive. USB Mass Storage Device may be listed twice. One may contain a memory card reader or other mass storage drives.

4. Select your device that is labeled HP Personal Media Drive, and then click OK. This name of the drive may appear as Generic Volume followed by the assigned drive letter. A Safe to Remove Hardware message appears in the system tray at the bottom of your desktop letting you know that your drive is safe to disconnect.

5. Click Close.

6. Disconnect the drive from the PC.

Changing Disk Allocation

If you experience a Low Disk Space error message, and you want to change the disk allocation to a higher percentage for your HP Personal Media Drive:

1. Open Media Center.

2. Select Settings, TV, Recorder, and then select Recorder storage.

3. Change the disk allocation percentage setting by selecting the (+) or (−) option.
Updating Recorded TV List after Removing the HP Personal Media Drive

If you want to update your Recorded TV list after removing the drive:

1. Close Media Center.
2. Open Media Center.
3. If this does not update the files, restart the PC.

System Requirements to View Recorded TV Programs on Other PCs

To play back recorded TV files (.dvr-ms files) that were recorded on your PC on to another non-Media Center PC, the PC must have the following items installed:

- Windows XP operating system
- Windows XP Service Pack 1
- Windows Media Player 9 or later
- Software to play DVDs
- The audio and video codec file that allows Windows Media Player to play recorded TV programs (.dvr-ms files). You can find this file in Windows Update. Click Start, choose All Programs, and then click Windows Update. You can also go to the Windows Web site and search for this code file (Q810243).

If you want more information about this file, you can go to the Microsoft Web site at:

http://www.microsoft.com
A
adding
   CD tracks to the Music Library 35
   images to video file in WinDVD Creator 82
   music files to the Music Library
      from the hard disk drive 34
appendable disc 67
archiving files 69
   CD 69
   DVD 69
authoring your DVD 83
B
burning CDs and DVDs 65
buttons
   remote control 10
C
capturing
   capture card 80
   video and image 77
capturing video
   digital camcorder video 79
      requirements 79
CD
   creating a music CD in My Music 40
   playing in My Music 37
copying pictures to CD 54
creating
   CDs 65
   Music Library 34
   recovery CD/DVDs for the PC 70
creating music CDs
   to play in your car and home 66
   to play on your PC 66
D
desktop
   switching from Media Center 6
disc
   feature and compatibility 71
disc and drive compatibility
      information 70
disc labels 70
DVD movies
   changing
      audio settings 60
      language 60
   creating 77
   playing
      in Media Center 59
Eedit
   video files 81
   editing pictures 52
error messages 6
   common recording errors 25
   Image cannot be displayed 47, 51
   Low Disk Space 96, 99
F
FM radio, see radio
G
Guide, see Television Program Guide
H
HP Image Zone Plus 42
HP Personal Media Drive 91
HP Tunes
   adding music from a CD 28
   creating a queue list 32
   playing CDs 31
   using iTunes with Media Center 27, 28
I

image files
   adding 82
Internet radio 61
InterVideo WinDVD Creator
   see WinDVD Creator 77
iTunes 32
   adding music from a CD 28
   adding music from the Internet 29
   adding music from your hard disk drive 29
   adding music to library 28
   changing music information 30
   creating a playlist 31
   creating music CD 32
   creating music CDs 32
   features 73
   supported file types 30

M

Media Center
   navigating 5
   playing DVDs 59
   resizing window 6
   Start menu 4
   toolbars 6
   using with another program open 6
   viewing your pictures 50
Media Center, what you can do
   in My Music 27
   in My Pictures 41
   in My TV 13
   in My Videos 55
   in Radio 61
   memory card reader 41
music
   about burning a music CD 67
   burning CD 32
Music Library
   adding CD tracks 35
   creating 34
muvee autoProducer
   adding music to your movie 87
   adding pictures to your movie 86
   adding videos to your movie 86
   changing audio settings 88
   copying a movie to disc 89
   features 75
   getting started 85
   making a movie 88
   setting the style 87
   using 77
My Music 27
   copying music to CD 40
   creating a queue list 38
   deleting music from the My Music library 35
   finding and playing an album 38
   playing a song 37
   playing an album 37, 38
   playing music 36
   playing songs chosen randomly by Media Center 37
   supported file types 36
My Pictures 41
   editing pictures 52
   printing pictures 52
   rotating pictures 53
   turning captions on or off 53
   types of files it can display 47, 51
   viewing a slide show with music 46, 51
   viewing pictures 50
   viewing pictures as a slide show 50
My TV 13
  advanced recording options 22
  icons 22
  manually downloading the Guide 19
  play recorded TV programs 25
  recording TV from the Guide 22
  recording TV manually 23
  recording TV programs 22
  recording TV programs without a Guide 23
  searching for TV programs 20
  sorting shows 25
  Television Program Guide errors 17
  time shifting 15
  using the remote control 15
  watching TV programs 14
My Videos 55
  organizing and storing videos 56
  playing digital videos 56
  sorting videos 57

Q
  queue list
    creating in HP Tunes 32
    creating in My Music 38

R
  radio
    connecting antenna to PC 61
    getting reception 61
  Radio window 61
    organizing pre-set radio stations 63
    playing FM stations 61
    playing radio in Media Center 61
    recording radio programs 63
  RealOne Player
    features 73
  recorded TV 25
  recording
    DVDs 77
    options in My TV 22
    radio programs 63
    TV shows 22
      how to stop recording 22
  recording TV from the Guide 22
  recording TV shows
    making sure a show is being recorded 22
    manually 23
    single shows or series, canceling 22
    using the Guide 22
    when two scheduled for same time 22
  recording VHS files direct to DVD 85
  RecordNow! 65, 77
    archiving files 69
    creating music CD to play on your PC 66
    creating music CDs 65
      for car and home CD players 66
    storing files on a DVD or CD 67
  recovery CD/DVDs for the PC 70
  remote control
    buttons 10, 11
    using in My TV 16
  rotating pictures 53
S
searching for programs 20
settings
  background color 7
  calibration settings 7
  for phone call notification 7
  for sound 7
  general 7
  Internet connections 7
  parental controls 7
  remote control and remote sensor 7
Shared Video folder 55
slide show
  displaying information about pictures 50
  viewing pictures 50
  viewing with music 50
sorting TV shows
  by category 25
  by date 25
  by name 25
Start menu
  Media Center 3
storing files
  about storing data files 68
  using RecordNow! 67
T
Television Program Guide
  filter categories 18
  no data available 17
  recording TV programs 22
  recording TV without the Television Program
    Guide 23
  searching for TV programs 20
  setting up a download method 19
  using the More information button 18
  viewing 18
troubleshooting
  image not displayed in My Pictures 47, 51
  radio reception 62
  unable to get correct TV Program Guide 6
TV
  searching for shows by category 21
  time shifting 15
  using digital video recorder while watching 15
  watching 14
TV shows
  copying to CDs or DVDs 77
  not recorded 25
V
video
  capturing 79
video editing
    getting started with muvee autoProducer 85
video files
  recording 69
video movies
  sorting 57
video recording length 70
W
Windows Media Player
  features 73
  setting as default player 30, 36
  types of files 30, 36
Windows Movie Maker 2.0
  features 74
WinDVD Creator
  adding audio effects 82
  adding images 82
  adding title effects 83
  adding transition effects 83
  Authoring your DVD 83
  capturing analog video 80
  capturing digital camcorder video 79
  capturing videos and pictures 77
  edit 77
  editing video files 81
  features 75
  getting started 78
  help 77
  making a movie 84
  Media Library 78
  Preview window 78
  recording VHS files directly to DVD 85
  Storyboard 78
  using the Media Library 78
WinDVD player
  features 74